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LIMITED WARRANTY & LIMITATION OF LIABILITY 

Each Fluke product is warranted to be free from defects in material and 
workmanship under normal use and service. The warranty period is one 
year and begins on the date of shipment. Parts, product repairs and 
services are warranted for 90 days. This warranty extends only to the 
original buyer or end-user customer of a Fluke authorized reseller, and 
does not apply to fuses, disposable batteries or to any product which, in 
Fluke's opinion, has been misused, altered, neglected or damaged by 
accident or abnormal conditions of operation or handling. Fluke warrants 
that software will operate substantially in accordance with its functional 
specifications for 90 days and that it has been properly recorded on non-
defective media. Fluke does not warrant that software will be error free or 
operate without interruption.  

Fluke authorized resellers shall extend this warranty on new and unused 
products to end-user customers only but have no authority to extend a 
greater or different warranty on behalf of Fluke. Warranty support is 
available if product is purchased through a Fluke authorized sales outlet or 
Buyer has paid the applicable international price. Fluke reserves the right 
to invoice Buyer for importation costs of repair/replacement parts when 
product purchased in one country is submitted for repair in another 
country. 

Fluke's warranty obligation is limited, at Fluke's option, to refund of the 
purchase price, free of charge repair, or replacement of a defective 
product which is returned to a Fluke authorized service center within the 
warranty period. 

To obtain warranty service, contact your nearest Fluke authorized service 
center or send the product, with a description of the difficulty, postage and 
insurance prepaid (FOB Destination), to the nearest Fluke authorized 
service center. Fluke assumes no risk for damage in transit. Following 
warranty repair, the product will be returned to Buyer, transportation 
prepaid (FOB Destination). If Fluke determines that the failure was caused 
by misuse, alteration, accident or abnormal condition of operation or 
handling,  Fluke will provide an estimate of repair costs and obtain 
authorization before commencing the work. Following repair, the product 
will be returned to the Buyer transportation prepaid and the Buyer will be 
billed for the repair and return transportation charges (FOB Shipping 
Point). 



Wireless Logger 
Users Manual 

    

THIS WARRANTY IS BUYER'S SOLE AND EXCLUSIVE REMEDY AND 
IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
FLUKE SHALL NOT BE LIABLE FOR ANY SPECIAL, INDIRECT, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSSES, 
INCLUDING LOSS OF DATA, WHETHER ARISING FROM BREACH OF 
WARRANTY OR BASED ON CONTRACT, TORT, RELIANCE OR ANY 
OTHER THEORY. 

Since some countries or states do not allow limitation of the term of an 
implied warranty, or exclusion or limitation of incidental or consequential 
damages, the limitations and exclusions of this warranty may not apply to 
every buyer. If any provision of this Warranty is held invalid or 
unenforceable by a court of competent jurisdiction, such holding will not 
affect the validity or enforceability of any other provision. 

To locate an authorized service center, visit us on the World Wide Web: 
www.fluke.com or call Fluke using the phone numbers listed below: 

USA and Canada:  1-888-99-FLUKE (1-888-993-5853)  
Europe:  +31 402-678-200  
Japan:  +81-3-3434-0181  
Singapore:  +65-*-276-6196  
Anywhere in the world:  +1-425-356-5500 
 

Fluke Corporation Fluke Europe B.V. 
P.O. Box 9090 P.O. Box 1186 
Everett, WA  98206-9090 5602 BD Eindhoven 
U.S.A. The Netherlands 



  
  

  

 

This product is classified Class III equipment by IEC 1010-1 Annex H. 
 

INTERFERENCE INFORMATION 

The Wireless Logger 900 MHz and 2.4 GHz systems comply with Part 15 
of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause 
undesired operation. 
 

EUROPEAN TELECOMMUNICATIONS STANDARDS INSTITUTE 
Statement of Compliance 

Information to User 
The Wireless Logger 2.4 GHz systems have been tested and found to 
comply with the European Telecommunication Standard ETS 300.328. 
This standard covers Wideband Data Transmission Systems referred to in 
the CEPT recommendation T/R 10.01. This type of accepted equipment is 
designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. 
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SAFETY TERMS IN THIS MANUAL 
This instrument has been designed and tested in accordance with IEC 
Publication 1010, Safety Requirements for Electrical Measuring, Control and 
Laboratory Equipment. This User Manual contains information, warnings, 
and cautions that must be followed to ensure safe operation and to maintain 
the instrument in a safe condition. Use of this equipment in a manner not 
specified herein may impair the protection provided by the equipment. 
Terms in this Manual 
This instrument has been designed for IEC 664, Installation Category II use. 
It is not designed for use in circuits rated over 48000VA. 

Warning statements identify conditions or practices that could result in 
personal injury or loss of life. 

Caution statements identify conditions or practices that could result in 
damage to the equipment or other  property. 

Symbols Marked on Equipment 

S DANGER � High Voltage 

Q Ground (earth) terminal 

 Protective ground (earth) terminal. Must be connected to safety 
earth ground when the power cord is not used. 

W Attention � refer to the manual. This symbol indicates that 
information about the usage of a feature is contained in the 
manual. This symbol appears in the following two places on the 
instrument rear panel: 

1. Ground binding Post (left of line power connector). 

2. Alarm Outputs/Digital I/O Connectors. 
AC Power Source 
The instrument is intended to operate from a power source that will not 
apply more than 264V ac rms between the supply conductors or between 
either supply conductor and ground. A protective ground connection by 
way of the grounding conductor in the power cord is essential for safe 
operation. 



  
  

  

DC Power Source 
The instrument may also be operated from a 9 to 16V dc power source 
when either the rear panel ground binding post or the power cord 
grounding conductor is properly connected. 
Use the Proper Fuse 
To avoid fire hazard, use only the fuse specified on the line voltage 
selection switch label, and which is identical in type voltage rating, and 
current rating. 
Grounding the Instrument 
The instrument utilizes controlled overvoltage techniques that require the 
instrument to be grounded whenever normal mode or common mode ac 
voltages or transient voltages may occur. The enclosure must be grounded 
through the grounding conductor of the power cord. To avoid electrical 
shock, plug the power cord into a properly wired earth grounded receptacle 
before connecting anything to any of the instrument terminals. A protective 
ground connection by way of the grounding conductor in the power cord is 
essential for safe operation. 
Use the Proper Power Cord 
Use only the power cord and connector appropriate for proper operation of 
this instrument in your country. 
Use only a power cord that is in good condition. 
Refer cord and connector changes to qualified service personnel. 
Do Not Operate in Explosive Atmospheres 
To avoid explosion, do not operate the instrument in an atmosphere of 
explosive gas. 
Do Not Remove Cover 
To avoid personal injury or death, do not remove the instrument cover. Do 
not operate the instrument without the cover properly installed. There are 
no user-serviceable parts inside the instrument, so there is no need for the 
operator to ever remove the cover. 
Do Not Attempt to Operate if Protection May be Impaired 
If the instrument appears damaged or operates abnormally, protection may 
be impaired. Do not attempt to operate it. When is doubt, have the 
instrument serviced.
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Quick Start 

  

Introduction 
The 2625A/WL and the 2625A/W2 Wireless Logger are portable, easy-to-use 
wireless data acquisition tools that enable quick, immediate data collection and 
transmission to a PC from locations once considered too remote, inaccessible, or 
environmentally hostile for a real-time monitoring system. Each satellite 
accommodates up to 21 analog channels that can be set up within minutes, and is 
ideally suited for PC-based data acquisition applications where quick, convenient 
setup is important. The 2625A/WL is a 900 MHz FCC approved system intended 
for use primarily in the US and has a range of up to 400 meters (1/4 mile). The 
2625A/W2 is a 2.4 GHz system and is ETSI approved for use in many European 
countries as well as the US. The 2625A/W2 has a typical line-of-site range of 240 
meters (800 feet). 
The Wireless Base Station consists of a wireless modem and the Wireless Logger 
for Windows application software which supports up to 20 satellite instruments 
from a single base station. The Wireless Logger for Windows software offers 
increased efficiency by allowing the PC to gather data in the background, while 
freeing the user to work with a word processor, spreadsheet, or other program in 
the foreground. 

Assumptions 
This Quick Start section assumes the following conditions: 
• You are already running and are familiar with Microsoft Windows 3.1 or 

Windows 95 
• You are using COM2 (communication port 2) on your PC to communicate 

with the Wireless Logger satellite. (If you are using COM1, you need to 
change all mentions of COM2 in this Quick Start section to COM1.) 
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• You leave the Wireless Logger near your PC while performing the Quick Start 
section�s exercises. This allows quick access to the Wireless Logger if you 
should have difficulties with any of the exercises. After performing the 
exercises in the Quick Start section, you can move the Wireless Logger out to 
its remote location. 

Use of this Quick Start Section for 2625A/WL and 2625A/W2 Modem Setup 
If you are using a 2625A/WL (900 MHz modem) for this demonstration, follow 
Steps 4 and 5 for base station and remote modem configuration. 
If you are using the 2625A/W2 (2.4 GHz modem), follow Steps 4a and 5a for 
modem configuration. 
Steps 1, 2, and 6 through 16 should be performed regardless of which Wireless 
Logger model you are using.  

Note 
The serial port configuration in this Quick Start section is written 
around Windows 3.1 terminal emulator. If you are using Windows 
95, you should use Hyperterminal, which is located in your Windows 
95 accessories folder. Use port settings as shown in Step 2 of this 
section. 
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Step 1 Configure Hydra�s Universal Input Module 
Connect the type-T thermocouple provided to Channel 1 and 2 of the Universal 
Input Module in parallel as shown below. 

L

L

STRAIN RELIEF

 
rs128f.eps 

 
Universal Input Module 

Step 2 Set the Wireless Logger�s Communications Parameters 
Set the Wireless Logger�s communications parameters to: 9600 baud, no parity, 
echo off.  
Perform the following actions from the Wireless Logger�s front panel: 
1. Press the K button then the L/COMM button to view the Wireless 

Logger�s communications parameters. 
2. Press the G and D buttons to select 9600 baud and press the E button. 
 Press the G and D buttons to select �no� parity and press the E button. 

(If you are using a 2635A Data Bucket, set CTS to off.) 
3. Press the G and D buttons to select echo off and press the E button. 
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Step 3  Install the Wireless Logger for Windows Software 
Install the Wireless Logger for Windows demo disk in your a: drive (floppy drive) 
and use the Run command to run A:/Setup.exe. A Windows group similar to that 
shown below will be created. 

 
rs002s.bmp 
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12345678

HOST COMPUTER BACK PANEL

6–9 V DC

PWR

RD

CD

Base Station Modem

Serial Number

Description 36893PC1

Host-to-Modem Cable

Connect to  COM port.
Use DB25-to-DB9 adapter,
as required.

Modem Label

Modem being Configured

Modem Power Module.
Connect to 115V ac/60 Hz

source.

RS-232 connector (DB9).
Connect to Modem 

RS-232 Port.

Power connector.
Connect to Modem 
6–9V DC port.

 
rs024f.eps 

Basic Modem Connections 

Step 4 Configure the Base Station�s Wireless Modem (900 MHz) 
The base station�s modem is configured using the Terminal Emulator included 
with Microsoft Windows 3.1 or with Hyperterminal found in the accessories 
programs in Windows 95. 
1. Start the Terminal Emulator or Hyperterminal. 
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Note 
The Terminal Emulator assumes you are using COM2. If you are 
using COM1, select Communications... under Settings and change 
the communication port to COM1. 

2. Press the white reset button located on the back of the modem next to the  RS-
232 connector. This will bring up the following main menu: 

 
rs004s.bmp 

3. Reset the modem to factory default settings by entering R <ENTER>. Enter Y 
<ENTER> to reset the modem.  
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4. Move to the Serial Port configuration menu by entering S <ENTER>. 
Configure the serial port as shown in the following table: 

Base Station Modem Serial Port Configuration 

Match the following configuration Steps to match the configuration 

B - Baud Rate                              19200 B <ENTER> 5 <ENTER> 

E - Echo Mode None E <ENTER> N <ENTER> 

F -  Flow Control 
 Generate Xon/Xoff Disabled 
 Generate CTS Disabled
 Generate DSR Disabled 
 Recognize Xon/Xoff Disabled 

F <ENTER> 
<ESC> 
defaults are correct 

M - Maximum Line Length 300  M  <ENTER> 300 <ENTER> 

I - Input Time-out Off Go to the next step (default is correct) 

A - Add a Delimiter None Go to the next step 

R - Remove a Delimiter None R <ENTER> 13 <ENTER> 
R <ENTER> 10 <ENTER> 

  
5. Enter <ESC> to back up to the main menu. Move to the Advanced 

Configuration menu, by entering A <ENTER>. Configure the advanced 
communication items as shown in the following table: 

Advanced Base Station Modem Configuration 

Match the following configuration Steps to match the configuration 

B - Broadcast Address             Base station�s 
                                                  serial number]* 

B <ENTER> [base station�s serial number]  
<ENTER> (found on the bottom of the modem) 

E - Enable Broadcast Go to the next step (default is correct) 
D - Destination Serial # None Go to the next step (default is correct) 
C - Subchannel 1 Go to the next step (default is correct) 
S - Serial # Filter None Go to the next step (default is correct) 
T - Type Filter Broadcast T <ENTER>  B <ENTER> 
L - Lost Communication Continue Go to the next step (default is correct) 
O - Operating Mode Packetized O <ENTER>  This element toggles between 

packetized and pass-through mode 
*Each Wireless Logger network must have its own unique broadcast address and the address 
must be identical between the base station and each Wireless Logger satellite in the network. It 
is recommended to use the base station�s serial number as this unique number. 
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6. Enter <ESC> to back up one menu level to the main menu. Enter D 
<ENTER> to display the base station�s current configuration. It should be 
configured as shown below. If not, repeat part 4 and 5 of Step 4. Press 
<ENTER> to move back to the main menu. 

Parameter settings
Serial #: [Base station serial #]

Serial Port
Operating Mode: Packetized

Echo Mode: None
Baud Rate: 19200
Delimiters: None

Max Length: 300
Input Time-out: Off

XON/XOFF Generation: Disabled
CTS Generation: Disabled

XON/XOFF Recognition: Disabled
DSR Generation: Disabled

Network
Radio Channel: 4

Subchannel: 1
Radio Speed: 121K Baud

Broadcast Address: [Base station serial #]

Dest. Serial #: None
Serial # Filter: None

Lost Communication: Continue
Type Filter: Broadcast

 
rs134f.eps 

7. Important: Once the PC base station�s wireless modem is properly configured, 
launch it into operating mode by entering L <ENTER>. At the prompt enter Y 
<ENTER> to launch the modem. Launching the modem stores its 
configuration in the modem�s EEPROM and exits the modem�s configuration 
mode. The base station modem is now configured and operational. 
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Step 4a Base Station Modem Configuration (2.4 GHz) 
The base station�s modem is configured using the Terminal Emulator or 
Hyperterminal included in Microsoft Windows 3.1 and Windows 95. 
1. Start Terminal Emulator or Hyperterminal. 
2. Using a paperclip or similar device, press the �configure� button located on 

the front panel of the modem. This will bring up the following: 

MAIN MENU

1) View configuration
2) Change configuration
3) Reset configuration to default
4) View event log
5) Resume operation

 
rs122f.eps 

3. Reset the modem to factory default settings by entering 3 <ENTER>, Y 
<ENTER>, then 2 <ENTER> to change configuration. 

4. Move to the Radio configuration menu by entering 1 <ENTER> and change 
the settings to match those shown here: 

RADIO SETTINGS

1) Node type (Master)
2) Domain (0)
3) Channel (1)
4) Subchannel (1)
5) Transmit count (Infinite)
6) Retry interval (1000 milliseconds)
7) Receive filter (None)
8) Destination address (Broadcast)

 
rs123f.eps 
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5. Press <ENTER> to return to the modem configuration menu and select Serial 
port settings by entering 2 <ENTER>. Change the base station�s serial port 
settings to match those shown here: 

SERIAL PORT SETTINGS

1) Baud (19200)
2) Data bits (8)
3) Stop bits (1)
4) Parity (None)
5) Software XON/XOFF flow control (Disabled)
6) Hardware RTS/CTS flow control (Disabled)
7) Hardware DTR/DSR flow control (Disabled)

 
rs119f.eps 

6. Enter the Data Packet settings by entering 3 <ENTER> and change the 
settings to match the following: 

DATA PACKETING SETTINGS

1) Data mode (Packetized)
2) Line length (300)
3) Input timeout (10)
4) Delimiters (none)

 
rs120f.eps 

7. Return to the main menu and select item 5 �Resume Operation� to review and 
save the changes to the modem. The menu changes should match those below. 
If the changes are correct enter Y <ENTER> to save the current configuration. 
To make corrections to the settings, enter <ENTER>, and return to the main 
menu and make corrections as needed. 
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Current Configuration

Radio:
Node type = Master Domain = 0

 Channel = 1 Subchannel = 1
Transmit Count = Infinite Retry interval = 1000 milliseconds

 Receive filter = None
 Destination address = N/A
Serial port:
 Baud = 19200
 Data bits = 8
 Stop bits = 1
 Parity = none
 Flow control = XON/XOFF: Disabled
Data packeting:
 Protocol = Packetized
 Line length = 300
 Input timeout = 10
 Delimiters = none

 
rs121f.eps 

Step 5 Configure the Remote Modem (900 MHz) 
Now that the base station modem is configured, you need to configure the remote 
modem. Disconnect the base station modem from the PC and connect the remote 
modem to the PC. Be sure you do not confuse the two modems since they are 
configured differently. If you have not already done so, label the two modems 
Base Station and Remote with the labels included with the Wireless Logger. 
1. Press the while reset button on the remote modem to enter the main menu. 
2. Reset the modem to factory default settings by entering R <ENTER>. Enter Y 

<ENTER> to reset the modem. 
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3. Move to the Serial Port configuration menu, by entering S <ENTER>. 
Configure the serial port as shown in the following table: 

Serial Port Configuration 

Match the following configuration Steps to match the configuration 

B - Baud Rate 9600 B <ENTER>   4 <ENTER> 
E - Echo Mode None E <ENTER>   N <ENTER> 
F - Flow Control 
 Generate Xon/Xoff Enabled 
 Generate CTS Disabled 
 Generate DSR  Disabled 
 Recognize Xon/Xoff Disabled 

F <ENTER> 
X <ENTER> 
<ESC> 
The rest of Flow Control�s parameters are 
correct 

M - Maximum Line Length 300 M <ENTER>   300 <ENTER> 
I - Input Time-out Off Go to the next step (default is correct) 
A - Add a Delimiter 10 Go to the next step 
R - Remove a Delimiter 10 R <ENTER>     13 <ENTER> 

 
4. Enter <ESC> to back up to the main menu. Move to the modem�s Advanced 

Configuration menu, by entering A <ENTER>. Configure the advanced 
communication items as shown in the following table: 

Advanced Serial Port Configuration 

Match the following configuration Steps to match the configuration 

B - Broadcast Address             (base station�s 
                                                  serial number*) 

B <ENTER> [base station�s serial number]  
<ENTER> Do not enter the remote modem�s 
serial number. Enter the serial number of the 
base station (the modem you previously 
configured). 

E - Enable Broadcast T <ENTER>  B <ENTER> 

D - Destination Serial # Broadcast Go to the next step (this was configured by the 
step above) 

C - Subchannel 1 Go to the next step (default is correct) 

S - Serial # Filter (base station�s 
                                                  serial number*) 

S <ENTER> [base station�s serial number] 
<ENTER> 

T - Type Filter Directed T <ENTER>  D <ENTER> 

L - Lost Communication Continue Go to the next step (default is correct) 

O - Operating Mode Pass-Through Go to the next step (default is correct) 

Each Wireless Logger network must have its own unique broadcast address and the address 
must be identical between the base station and each Wireless Logger satellite in the network. It 
is recommended to use the base stations serial number as this unique number. 
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5. Enter <ESC> to back up one menu level to the main menu. Enter D 

<ENTER> to display the remote modem�s current configuration. It should be 
configured as shown below. If not, repeat part 3 and 4 of Step 5. 

Parameter settings
Serial #: [Remote serial #]

Serial Port
Operating Mode: Pass-Through Delimiters: 10

Echo Mode: None Max Length: 300
Baud Rate: 9600 Input Time-out: Off

XON/XOFF Generation: Disabled XON/XOFF Recognition: Disabled
CTS Generation: Disabled DSR Generation: Disabled

Network
Radio Channel: 4 Radio Speed: 121K Baud

Subchannel: 1 Broadcast Address: [Base station serial #]

Dest. Serial #: Broadcast Lost Communication: Continue
Serial # Filter: [Base station serial #] Type Filter: Directed

 
rs135f.eps 

6. Press <ENTER> to move back to the main menu. 
7. Once the remote modem is properly configured, launch it into operating mode 

by entering L <ENTER>. At the prompt enter Y <ENTER> to launch the 
modem.  

8. Since both the base station modem and the remote modem are now 
configured, exit the terminal emulator by clicking on Exit under File in the 
terminal emulator�s upper left hand corner. A dialog box appears asking if you 
want to save the terminal emulator�s configuration. Click on No. 

9. Disconnect the remote modem from the PC and reconnect the base station 
modem. The remote modem now can be connected to the Wireless Logger as 
shown above. 

Step 5a Configure the Remote Modem (2.4 GHz) 
Now that the base station modem is configured, you need to configure the remote 
modem. Disconnect the base station modem from the PC and connect the remote 
modem to the PC. Be sure you do not confuse the two modems since they are 
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configured differently. If you have not already done so, label the two modems 
Base Station and Remote with the labels included with the Wireless Logger. 
1. Start Terminal Emulator or Hyperterminal. 
2. Using a paperclip or similar device, press the �configure� button located on 

the front panel of the modem. This will bring up the following: 

MAIN MENU

1) View configuration
2) Change configuration
3) Reset configuration to default
4) View event log
5) Resume operation

 
rs122f.eps 

3. Reset the modem to factory default settings by entering 3 <ENTER> Y 
<ENTER>. Then 2 <ENTER> to change configuration. Move to the Radio 
configuration menu by entering 1 <ENTER> and change the settings to match 
those below. Take special note of menu selection #7 �Receive Filter� and #8 
�Destination Address�. In these fields enter the serial number found on the 
underside of the base station modem. This will set the remote modem to listen 
and talk only with the base station modem. 

RADIO SETTINGS

1) Node type (Station)
2) Domain (0)
3) Channel (1)
4) Subchannel (1)
5) Transmit count (Infinite)
6) Retry interval (1000 milliseconds)
7) Receive filter (base station serial #)
8) Destination address (base station serial #)

 
rs124f.eps 
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4. Press <ENTER> to return to the modem configuration menu and select serial 
port settings by entering 2 <ENTER>. Change the base station�s serial port 
settings to match those shown in the following: 

SERIAL PORT SETTINGS

1) Baud (9600)
2) Data bits (8)
3) Stop bits (1)
4) Parity (None)
5) Software XON/XOFF flow control(Generate)
6) Hardware RTS/CTS flow control(Disabled)
7) Hardware DTR/DSR flow control(Disabled)

 
rs125f.eps 

5. Enter the Data Packet settings by entering 3 <ENTER> and change the 
settings to match the following: 

DATA PACKETING SETTINGS

1)  Data mode (Passthrough)
2)  Line length (300)
3)  Input timeout (Infinite)
4)  Delimiters (1:10)

 
rs126f.eps 

6. Return to the main menu and select item 5 �Resume Operation� to review and 
save the changes to the modem. The menu changes should match those shown 
below. If the changes are correct enter Y <ENTER> to save your current 
configuration. To make corrections to the settings enter <ENTER>, and return 
to the main menu and make corrections as needed. 
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Current Configuration

Radio:
Node type = Station Domain = 0

 Channel = 1 Subchannel = 1
 Transmit count = Infinite Retry interval = 1000 milliseconds
  Receive filter = (base station serial #)

 Destination address = (base station serial #)
Serial port:
 Baud = 9600
 Data bits = 8
 Stop bits = 1
 Parity = none
 Flow control = XON/XOFF: Generate
Data packeting:
 Protocol = Passthrough
 Line length = 300
 Input timeout = Infinite
 Delimiters = 10

 
rs127f.eps 

Step 6 Start the Wireless Logger for Windows Software Program 
Start Wireless Logger for Windows by double-clicking on the Wireless Logger 
icon in the Fluke Wireless Logger group. 

Step 7 Configure Hydra for Scanning 
Configure Hydra to measure the T type thermocouple you previously connected to 
channels 1 and 2 of the universal input module. 
1. Change Hydra�s configuration by clicking on the Edit Hydra Config... 

button located in the upper left hand corner of Wireless Logger for Windows. 
This brings up the main configuration menu for Hydra 1. With this 
configuration menu, you can set Hydra�s measurement rate, define its 
channels, configure the data file, set Hydra�s communication parameters, etc. 

2. Change Hydra�s scan interval from 5 seconds to 2 seconds by highlighting the 
5 inside the Scan Parameter box and typing 2. Do not press <ENTER>. 



Wireless Logger 
Users Manual 

 

 18  

3. Change Hydra�s temperature units to Fahrenheit by clicking on Fahrenheit 
in the Temperature Units box. The �Hydra Configuration - Hydra 1� dialog 
box should appear as shown below: 

 
rs129s.bmp 
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Step 8 Configure Hydra to Communicate via Wireless Modems 
1. Move to the communications configuration dialog box by clicking on the 

Communication... button.  
2. Click on Remote Hydra (Wireless) in the upper left hand corner to specify 

that you are using a Wireless Logger. Notice when you click this radio button 
that a number of entry boxes below become active. 

3. In the �Remote Hydra� entry box, type the serial number of the remote modem 
in the Address box. Do not press <ENTER>. 

4. In the �Base Station Modem� entry box, select COM2 as the RS-232 Port 
and 19.2k as the Baud Rate. 
The �Communication Configuration - Hydra 1� dialog box should appear as 
shown in the following: 

 
rs130s.bmp 

 

Step 9 Verify Communications 
Now that the communication parameters are configured, test the connection with 
the Wireless Logger Satellite to verify communication.  
1. Click on the Verify Connection button to test communications with Hydra. 

Wireless Logger for Windows responds with �Hydra 1: Connection 
Successful� if it can connect with the Satellite. Click on OK to remove the 
new dialog box.  
If Wireless Logger for Windows does not communicate with the Satellite, 
check the following: 
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• Make sure Hydra, the base station modem, and the satellite modem are 
powered. 

• Check the cabling between the PC and the base station modem, referring 
to the �Basic Modem Connections� figure. 

• Check the cabling between the Hydra and satellite modem. 
• Check the configuration of both modems with the terminal emulator by 

repeating Steps 4 and 5. 
• If you still are having difficulties, refer to Chapter 2. 

2. Click on OK to exit the communications dialog box. 
 

Step 10 Configure Channels 1 and 2 
Configure Hydra for T type thermocouples on channels 1 and 2. 
1. Move to the Channels configuration menu by clicking on the Channels... 

button. 
2. The default settings for Wireless Logger configure channels 1, 2, and 3 for 

VDC in the 3V range. 
 Configure channels 1 and 2 for type T thermocouples. Select channels 1 and 2 

by dragging the mouse over channels 1 and 2. Both channels should now be 
selected. Click on the Function... button. Under Function, select 
�THERMOCOUPLE�. Under Range, select T. Select OK to enter the 
function configuration. 

3. Turn channel 3 off by selecting Channel 3. Next, click on the Function... 
button. Under Function, select �Off�. Select OK to enter the function 
configuration. 

4. Change channel 1�s label from Ch1 Label to Temp 1 by selecting channel 1. 
Next highlight the Channel Label field and enter �Temp 1�. Click on the 
Apply Label button to save the new label. Repeat this step for channel 2 and 
change its label to �Temp 2�. 

5. Click on OK to exit out of the channels configuration dialog box. 
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Step 11 Create a Data File  
Next, create a data file to store all the data collected by Hydra.  
1. Click on the Data File... button to move to the data file menu. The following 

dialog box appears: 

 
rs050s.bmp 

 

2. Click on Enable Data File Recording box to create a data file. Click on 
Select Data File... button to enter the name of the data file. Enter 
�TUTORIAL.CSV� for the data file name. Select OK.  

3. Select OK again to move back to the Hydra configuration dialog box. 
4. Click on OK to exit the Hydra configuration dialog. You are now back at the 

main window of Wireless Logger for Windows. This window provides you 
with a summary of how the current Hydra is configured.  
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Step 12 Save the Wireless  
Logger Setup Save the current Wireless Logger setup to a file so you can retrieve 
it at a later date.  
1. Select Save Logger Setup from Setup on the main menu. Enter 

�TUTORIAL.STP� as the name of the setup file.  
2. Click on OK to save the setup file. 

Step 13 Create a Real-Time Trend Plot 
Create a real-time trend plot so you can display the data from the thermocouple on 
channels 1 and 2 in real-time.  
1. Select Create Plot from Plots on the main menu. A new window titled �Plot 

1� appears. 
2. Select Settings... from the Setup menu in Plot 1�s window. Inside the Y-axis 

scale box type 90 for the Plot Maximum and 60 for the Plot Minimum. 
Select seconds in the X-axis Time Span box and type 80 Seconds. 

3. Click in the Plot Channels... button to select the channels to plot. Channel 1 
of Hydra 1 is already entered for you in the Selected Channels box. You only 
need to add channel 2 of Hydra 1 to the plot. Click on Ch2 (Temp 2) making 
sure that instrument Hydra 1 is still selected. Click on Add Channel to add 
channel 2 to the plot. Select OK to move back to the settings dialog box. 
Select OK again to move back to Plots main menu. 

4. Change the Plot title and labels by selecting Labels... under the Setup menu. 
Under Plot Title, enter �Tutorial Plot�. Under Y-Axis Label, enter �Deg F�. 
Select OK to move back to the main plot window. 

Step 14 Start Hydra and the Real-Time Plot 
1. Move back to the Wireless Logger application by clicking in the Wireless 

Logger program�s window, which is the upper part of your screen.  
2. Start Hydra acquiring data by clicking on the Start Hydra button located 

below Wireless Logger main menu. 
3. Bring back the real-time trend plot by selecting Tutorial Plot under Plots on 

the main menu. From the Plot main menu, select Start! to start the real-time 
chart. 

 The real-time chart begins plotting the data collected by Hydra. If you rub the 
end of one of the thermocouples, you can increase the temperature and see the 
results in the trend plot as shown below. 
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4. Stop Hydra from acquiring data by moving back to the Wireless Logger 
program and selecting Stop Hydra button located under the main menu. 

5. Close the Hydra Logging Status menu by double-clicking in the upper left 
hand corner of the status box. 

6. Resave your Wireless Logger setup to save your plot configuration. Select 
Save Logger Setup under Setup. 

Step 15 Determine the Wireless Logger�s Communication Range 
Now that you have established communications with the Wireless Logger satellite 
and acquired data locally, you can take the satellite out to remote locations and 
test the wireless communication link. Wireless Logger for Windows provides a 
utility to make this quick and simple. The utility is called �Site Survey.� 
The utility works by continually incrementing the Wireless Logger�s totalizer. A 
dialog box on your PC keeps track of the number of increments sent to the satellite 
and the number of successes and failures in communicating with the Wireless 
Logger. By using the Wireless Logger to display the totalizer count, you can move 
your satellite around to different locations and determine whether you can 
communicate with the Wireless Logger. When you go out of the satellite�s 
communication range, the totalizer reading on the Wireless Logger stops 
incrementing. You will know when you are back in range of the Wireless Logger 
when the totalizer begins to increment again. 
1. Open the site survey utility by selecting Site Survey... under the Utilities 

menu. Click on Start to start the site survey. Note that the totalizer count in 
the dialog box begins to increment upwards. Since your satellite is next to 
your PC, the number of successful transmissions increments at the same pace 
as the totalizer count.  
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2. Press the Totalizer button ( O on the front of the Wireless Logger). The 
totalizer count is tracking the number of transmissions that the software is 
sending to the wireless modem. When the totalizer is incrementing, you know 
that the satellite is in communication range with the base station. 

3. Unplug the power from the Wireless Logger. Note that the number of 
successes no longer increments on the PC. Instead the number of failures 
begins to increment. This tells you that you are either out of communication 
range with the base station, or the base station or satellite is down. In the case 
of this Quick Start section, the satellite is down since it has lost power. 
Restore power to the Wireless Logger. The satellite�s totalizer begins to 
increment, and the number of successes also starts to increment. 

4. Stop the site survey utility by clicking on Stop. Click on Close to move back 
to the main configuration menu. 

Step 16 Exit Wireless Logger for Windows 
Exit Wireless Logger for Windows by clicking on Exit Application under Setup. 
The Wireless Logger Quick Start section gave you a brief overview of the 
Wireless Logger for Windows software and Wireless Logger satellites. In review, 
you performed the following steps: 
• Configured the Universal Input Module 
• Set the front panel communication parameters 
• Configured the base station�s wireless modem 
• Configured the remote modem 
• Installed the Wireless Logger for Windows software program 
• Configured the Wireless Logger for scanning 
• Configured the Wireless Logger to communicate via wireless modems 
• Verified communication between a Wireless Logger satellite and the base 

station 
• Configured channels 1 and 2 of the Wireless Logger 
• Created a data file 
• Saved a Wireless Logger setup 
• Created a real-time trend plot 
• Performed real-time data collection and plotting 
• Explored the site survey utility 
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Now that you have finished this Quick Start section, you are ready to take your 
Wireless Logger out to your remote locations and verify its communication. While 
you are exploring, try other locations as well. 
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Introduction 1-1. 
The Wireless Logger data acquisition tool (Wireless Logger tool) (Figure 1-1) 
consists of Hydra Data Loggers communicating with a Host Computer via a 
wireless modem radio link. The Host Computer (not included) controls all 
operations using the Wireless Logger for Windows software. Table 1-1 shows the 
conversion kits and component parts for assembling a Host Computer into a 
Wireless Logger Base Station (Base Station), and assembling a Hydra into a 
Wireless Logger Remote (Remote). 
The primary characteristics of the Wireless Logger tool are as follows: 
• Range. The Wireless Logger tool allows direct line of sight communications 

with the 900 MHz system and up to 1200 feet (365 meters) using the 2.4 GHz 
system. 

• Extendibility. A Host Computer operates up to 20 Wireless Logger Remotes 
simultaneously. Add and subtract Remotes at any time. 

• Flexibility. Freely position the Wireless Logger Remotes anywhere within 
range, from the simple to the most difficult-to-reach places. 

• Fast Setup. Install the modems, position the Wireless Logger Remotes, open 
Wireless Logger for Windows and begin operations. 

• Ease of Use. A few clicks of the mouse and the Wireless Logger Remotes go 
to work. Monitor measurements at any time at the Host Computer. 

Host Computer Requirements 1-2. 
• The Host Computer must meet the following minimum requirements: 
• System. IBM PC Compatible computer with an Intel 386 microprocessor or 

greater 
• Hard Disk Drive. Hard disk drive with 1 MB of available space 
• Floppy Disk Drive. Floppy disk drive 1.2 MB (5 ¼-inch) or 1.44 MB (3 ½-

inch) 
• Memory. 640 KB of main memory plus at least 3 MB extended memory 
• Monitor. Any monitor supported by Windows 
• Windows. Microsoft Windows version 3.1 or later 
• A mouse is optional but it facilitates operation. 
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Figure 1-1. Wireless Logger Data Acquisition Tool 
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Table 1-1. Wireless Logger Models, Options, and Accessories 

Part Number Description 

Models:  
2625A/WL 
2625A/W2 

Wireless Logger Data Acquisition Tool 
2625A Hydra Data Logger (Note 1) 
Wireless Modem (with Antenna, power supply, RS-232 cable) 
Soft Carrying Case for the Wireless Logger Tool 
Wireless Logger Users Manual 
Labels: Remote Modem and Base Station Modem 

2625A/WL-700 
2625A/W2-700 

Wireless Base Station Package 
Wireless Modem (with Antenna, power supply, RS-232 cable) 
Wireless Logger for Windows Software 
DB9 to DB25 RS-232 Cable Adapter 
Labels: Remote Modem and Base Station Modem 
Wireless Logger Users Manual 

Options:  

26X5A/WL-701 
26X5A/W2-701 

Hydra Wireless Logger Conversion Kit (Note 2) 
Wireless Modem (Antenna, power supply, RS-232 cable) 
Soft Carrying Case for the Wireless Logger  
Wireless Logger Manual 
Labels: Remote Modem and Base Station Modem 

26X5A/WL-704 Wireless Logger DC Power Kit 
Battery Pack for the Hydra and Wireless Modem 

26X5A/WL-902 Wireless Logger for Windows Software Package 
Software Disk Set (-99002) 
Wireless Logger Manual 

2620A-100 I/O Connector Set 
Universal Input Module 

2620A-101 Current Shunts, 10e, 0-100 mA, (qty. 12) 

Accessories  
C42 Wireless Logger Soft Carrying Case 

PV350 Pressure/Vacuum Transducer Module 

80i-410 Clamp-On DC/AC Current Probe 

80i-1010 Clamp-On DC/AC Current Probe 
Note 1. 2625A Hydra Data Logger includes: Universal Input Module, Hydra Starter Software 
             Package, T-Thermocouple, Users Manual, TL70 Test Lead Set, Power Cable. 
Note 2. Converts a standard Hydra 2625A Data Logger or 2635A Data Bucket into a Wireless  
             Logger. 
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The "Wireless Base Station Package" (see Table 1-1) configures the Host Computer 
as a Wireless Logger Base Station. A Base Station package includes the wireless 
modem, Wireless Logger for Windows software, cables, an adapter, and modem 
labels. 

Hydra requirements 1-3. 
The Wireless Logger tool requires one of two Hydra models: 
• 2625A Hydra Data Logger - Running software version 5.5 or higher 
• 2635A Hydra Data Bucket - Running any software version 
The "Wireless Logger Data Acquisition Tool" (Hydra included) or "Hydra 
Conversion Kit" (Hydra not included) configures a Hydra as a Wireless Logger 
Remote. A Remote package includes (in addition to the Hydra) the wireless 
modem, modem power module, cables and modem labels. The memory card 
feature is not used when a 2635A Hydra Data Bucket operates as the Hydra with 
the Wireless Logger tool. To view the 2625A Hydra Data Logger software 
version, at the Hydra front panel press the left/right arrow keys simultaneously. 
The larger number display is the software version. Press the CANCL key to clear 
display. 

Spread Spectrum Communications 1-4. 
The wireless modems (Figure 1-3 and 1-4) used with the Wireless Logger tool 
communicate using spread spectrum technology. Spread spectrum is a radio 
transmission technique used in radio frequency (rf) data communications. 
Developed originally for military use, spread spectrum provides non-jammable 
data links with a high degree of immunity to electrical interference from either 
natural or man-made sources. Spread spectrum transmission also has the ability to 
send data at much higher rates, approaching 10 Mb per second. The combination 
of noise immunity and high data rate transmission makes spread spectrum 
transmission technology ideally suited for the Wireless Logger data acquisition 
tool. 

Spread Spectrum Licensing 1-5. 
Spread spectrum operation with an effective radiated power (erp) of up to 1000 
milliwatts (1 watt) requires no FCC licensing. The rf output of the Wireless 
Logger is 500 mW for the 900 MHz system and 100 mV for the 2.4 GHz system 
which falls well within this category. 
In accordance with the Radio Communications Act of 1992 the Spectrum 
Management Agency (SMA) requires that an Apparatus License be obtained prior 
to use of the wireless modem in Australia and New Zealand. An application for 
this license may be obtained by contacting the SMA. This device has been 
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approved for use in Australia on channels 4, 5, 6 and 7 only. In New Zealand 
channel 7 is the only channel approved for use.  
The Wireless Logger 2.4 GHz has been certified as compliant with the European 
Telecommunications Standards Institute (ETSI) for wide band data transmission 
systems in the following countries: 

AT Austria IT Italy 
BE Belgium LU Luxembourg 
CA Canada NL Netherlands 
DK Denmark NO Norway 
FI  Finland ES Spain 
FR France SE Sweden 
DE Germany GB Great Britain 

Note 
Some countries may require that the end user obtain an operating or 
station license prior to actual operation with these modems. It is the 
responsibility of the end user to determine applicability of local 
licensing requirements. 

Spread Spectrum in Operation 1-6. 
Spread spectrum technology is fundamentally different from narrowband 
communications in the method of transferring data. Narrowband transmissions are 
narrowly centered on a carrier frequency with a typical information bandwidth of 
25 kHz (see Figure 1-2). Narrowband receivers, tuned to the carrier frequency, 
detect and demodulate the carrier, and recover the data. An interfering signal that 
falls on or near the narrowband carrier frequency corrupts the transmission, 
causing data errors and unreliable communications. 
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Spread Spectrum
Signal

Narrow Band SignalNarrow Band
Signal

Interfering Signal

Spread Spectrum CommunicationsNarrow Band Communications
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Figure 1-2. Comparing Narrow Band and Spread Spectrum Communications 

Spread spectrum avoids the problems of interfering signals by spreading the rf 
energy over a broader portion of the spectrum, up to 1,000 times broader than that 
used in narrowband communications (see Figure 1-2). Interfering signals come 
and go with little or no effect when using spread spectrum. The frequency range 
reserved for spread spectrum is 902 to 928 MHz and 2.4 to 2.4835 GHz. The 900 
MHz wireless modems divide this frequency range into seven channels. The 2.4 
GHz accommodates 15 channels. 
The 900 MHz spread spectrum transmitter uses a pseudo-random sequence and 
coded data signal to broadly phase-modulate a carrier. The transmitted data is 
effectively obscured, or �locked,� within a frequency band. At the receiver, the 
identical pseudo-random code used by the transmitter is generated in the receiver 
demodulator stage, reconstructing the original data signal. The coding of 
information at the transmitter and associated decoding at the receiver permits 
communication only with stations programmed with the same carrier-encrypted 
code sequence. In the Wireless Logger tool, the basis of the pseudo-random code 
in each of the wireless modems is the modem serial number. 
The 2.4 GHz system uses a spread spectrum frequency hopping technique. In this 
technique the center frequencies are rapidly shifted during transmission using a 
similar pseudo-random code assignment. 
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6–9 V DC
PWR

RD

CD

INDICATORS

CD (Carrier Detect) LED. Blinks when modem 
detects spread spectrum rf.

RD (Receive Data) LED. Blinks when RS-232 data 
is applied to modem for transmission.

PWR (Power) LED. Lights when power is applied to 
modem. Blinks if modem fails self test.

ANTENNA CONNECTOR (SMA-type)

1/4 λ ANTENNA

RS-232 CONNECTOR (DB9-type)

ENABLE/RESET PUSHBUTTON

POWER CONNECTOR (9V dc, 300 mA)
(Accepts standard 5.0 mm O.D./2.5 mm I.D. plug)
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Figure 1-3. 900 MHz Modem  
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POWER
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CD
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Antenna
Connector

Antenna
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Figure 1-4. 2.4 GHz Modem 
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1 2 3 4 5 6 7

901 903 905 907 909 911 913 915 917 919 921 923 925 927 929 MHz

CHANNELS: 1, 2, 3, 4, 5, 6, 7
NON-OVERLAPPING CHANNELS: 1, 3, 5, 7
RADIO SPECTRUM: 902 – 928 MHz 

CHANNEL BANDWIDTH: NOMINAL 2 MHz
BITS PER SECOND: 121K 
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Figure 1-5. Wireless Modem Channel Assignments (900 MHz) 

Spread Spectrum and Electrical Interference 1-7. 
The spread spectrum broadband modulation/demodulation scheme is the key to its 
ability to reject noise. Spread spectrum distributes a relatively small amount of 
data over a frequency band that is much larger than required to handle the amount 
of information being transmitted. In addition, the information is modulated with a 
random code pattern that distributes minute parts of the original signal across the 
entire channel bandwidth. Noise from electromagnetic interference (EMI) or radio 
frequency interference (RFI) is generated typically in industrial areas by 
mechanical devices such as electric motor brushes, corona, relays, solenoids, 
induction heaters, lighting, and communications equipment. Noise from these 
devices normally concentrates in random spikes through a particular portion of a 
frequency band, and are very narrow and relatively random when compared to the 
spread spectrum bandwidth. A noise spike radiated onto a portion of the spread 
spectrum frequency band has little or no effect on the information carried within 
the frequency band. 
The spreading technique used in spread spectrum not only helps to reduce the 
effects of signal interference, but also reduces the possibility of interference with 
other electronic devices. The broad carrier frequency limits the peak radiated 
power at any one area with the frequency band. As a result, this limited energy 
nearly eliminates the possibility that spread spectrum transmissions will create 
interference for other electronic instrumentation. 



Wireless Logger 
Users Manual 

1-12 

Using Spread Spectrum 1-8. 
Like all rf devices, spread spectrum transmissions are affected by the environment 
they are used in. Most limitations are relatively stable and predictable, usually 
caused by physical surroundings such as buildings and other structures, and can 
often be circumvented by a little planning. For example, spread spectrum modems, 
like any other radiowave transmitter, cannot transmit through a solid metal 
enclosure. A window or door opening, however, is often enough to allow the 
spread spectrum signal to pass "through" a metal wall. The 900 MHz wireless 
modem rf output of 500 mW provides a range of about 400 m. The range is 
somewhat less in buildings with significant metal content, and somewhat greater 
in outdoor line-of-sight applications. The 2.4 GHz  system has an rf output of 100 
mV and has a line of sight range of 300 m. 

System Operation 1-9. 
The Base Station sends commands and queries to the Remote Hydras, and the 
Remote Hydras respond with status and measurement data. Hydra temporarily 
stores the measurement scan records in its internal scan memory. On a polling 
basis, the Host Computer queries a Hydra for the scan record count. If the count is 
1 or more, the Host Computer reads the scan records one by one, checking each 
record before deleting it from the Hydra scan memory. After reading up to ten 
scans, the Host Computer moves on to the next Hydra and the process repeats. If 
an error occurs in reading a scan record, the Host Computer also moves on to the 
next Hydra. After querying the last Hydra, the polling cycle repeats. Hydras that 
failed to transmit a scan record during a particular poll are read on the next polling 
cycle. 

Wireless Logger for Windows Software 1-10. 
The Wireless Logger for Windows software provides an operating environment for 
the Wireless Logger tool. Wireless Logger for Windows builds a Hydra instrument 
and configuration database, transfers the configuration to the instrument, acquires 
data from the instrument and manages the acquired data. Some major features of 
Wireless Logger for Windows include: 
• Multiple Instruments. Supports up to 20 Wireless Logger Remotes in 

simultaneous operation via a single Host Computer COM port. 
• Local Instrument. Supports one Local Hydra instrument using an RS-232 

cable to an available Host Computer COM port. 
• Ease of Use. Provides fast and easy configuration and operation using menus 

and windows. 
• On-Line Help. Extensive on-line help provides instantaneous answers to any 

setup or operating question. 
• Multiple Data Files. Logs scan records to separate data files for each 

operating Wireless Logger Remote. 
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• Links other Windows Applications. Supports Dynamic Data Exchange 
(DDE) for linking Wireless Logger Remote measurement data with other 
Windows applications such as spreadsheets. 

• Trend Plots. Displays up to eight trend plots, each able to display eight 
channels selected from any operating Wireless Logger Remote. As an option, 
you can display the data for the plot channels in numeric form below the plot. 

For information on the features and operating characteristics, refer to Chapter 3 
"Using Wireless Logger for Windows." 

Options and Accessories 1-11. 
Table 1-1 summarizes the options and accessories for the Wireless Logger tool. 

How to Use this Manual 1-12. 
Detailed Hydra operations appear in the following user manuals: 
• 2625A Hydra Data Logger. Hydra 2620A Series II Data Acquisition 

Unit/2625A Series II Data Logger Users Manual (Part Number 686675) 
• 2635A Hydra Data Bucket. Hydra 2635A Series II Data Bucket Users 

Manual (Part Number 686698) 
The Wireless Logger Users Manual discusses how to use a Hydra in a Wireless 
Logger tool configuration. The manual begins with Quick Start, continues through 
six chapters, and ends with 5 appendices. 
• Quick Start. Allows the experienced user to quickly set up and start operating 

the Wireless Logger tool. It is at the front of this manual. 
• Chapter 1 Overview of the Wireless Logger Data Acquisition Tool. 

Provides an overview of the Wireless Logger tool, including the requirements 
and role of each system element, how the system operates, and features 
available in the operating software, Wireless Logger for Windows. 

• Chapter 2 Preparing the Base Station and Remotes. Provides step-by-step 
procedures for installing Wireless Logger for Windows, configuring the Base 
Station and Remote wireless modems for operation, connecting the Base 
Station and Remotes into a network, and testing and configuring the network 
using Wireless Logger for Windows. 

• Chapter 3 Using Wireless Logger for Windows. Provides procedures for 
operating the Wireless Logger tool. Includes configuration procedures, 
reading measurement data, trend plots, and data files. An extensive Reference 
section details all Wireless Logger for Windows characteristics and operations. 

• Chapter 4 Wireless Logger for Windows Reference. Provides complete 
descriptions in reference format for all Wireless Logger for Windows 
parameter selections. 
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• Chapter 5 Pruning and Grafting Utility. Provides complete instructions for 
operating the Pruning and Grafting Utility. This utility manipulates data files, 
combining separate data files into a single file, and filtering the data to obtain 
only the data of interest. 

• Chapter 6 Maintenance. Provides a list of the Wireless Logger tool 
replaceable parts and gives troubleshooting hints, including decoding wireless 
modem error codes. 

• Appendices: Ancillary information including Specifications, File Formats, 
Error Messages, Dynamic Data Exchange (DDE), and Exception Condition 
Handling. 

Unpacking and Inspection 1-13. 
Carefully remove the contents of the shipping container and inspect for damage or 
missing parts (see Table 1-1 for a list of parts). If any of the contents are damaged 
or anything is missing, contact the place of purchase immediately. Save the 
container and packing material. If repairs, equipment relocation, or extended 
storage are necessary, use the original container and packing material to prevent 
damage to the equipment. 
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Introduction 2-1. 
This chapter contains the information needed to completely set up the Base 
Station (Host Computer and Base Station Wireless Modem) and Wireless Logger 
Remotes (Hydra and Remote Wireless Modem). 
The following topics should be completed in sequence: 
• Installing Wireless Logger for Windows 
• Configuring the Base Station and Remote Modems 
• Connecting a Base Station, Remote, and Local Hydra 
• Creating a Wireless Logger for Windows Setup File 
• Placing the Base Station and Remotes 
• Using the Site Survey feature to Verify Operations 
• Connecting Hydra Analog and Digital Lines 

Installing Wireless Logger for Windows 2-2. 
Complete the following procedure to install Wireless Logger for Windows. A 
basic knowledge of MS-DOS and Windows operations is required. If any step is 
unfamiliar to you, refer to the DOS and/or Windows documentation. 
1. Insert the Wireless Logger for Windows disk into the A disk drive. (If the B 

disk drive is used, modify this procedure accordingly.) 
2. Select the Run... command from the File menu of the Windows Program 

Manager, opening the Run dialog box. 
3. Type a:\setup.exe in the Command Line: box. Click OK, opening the 

Wireless Logger Setup dialog box (below). 

 
rs020s.bmp 
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4. Verify in the dialog box that Space Available: exceeds Space Required. If this 
is not the case, click Cancel and erase unneeded files on the selected drive, 
and repeat this procedure. The default drive and directory for the Wireless 
Logger for Windows files is C:\WIRELESS. Modify the Drive and Setup 
Directory to suit or accept the defaults and click OK. 

5. Click OK in response to the Setup is Complete! message. A program group is 
created in Program Manager with four icons, as shown below. 

  
rs021s.bmp 

Configuring the Base Station and Remote Modems 2-3. 
The procedures below configure the Base Station (Host Computer) and Remote 
(Hydra) wireless modems for operation. All modem procedures take place at the 
Host Computer. The Remote modems include the Base Station modem serial 
number as part of their configuration procedure. If a Base Station modem is 
replaced in a network, all the associated Remote modems must be 
reconfigured to reflect the serial number of the new Base Station modem. 
The Base Station is the center of the network with radio links to the Remotes 
(Figure 2-1). To follow the convention of Wireless Logger for Windows, each 
Remote Hydra is identified as H1, H2, H3, etc. If there are several Base Stations, 
the Remote Hydra identifications are extended to include the associated Base 
Station, e.g., Base1/H1, Base1/H2, Base2/H3, etc. Each wireless modem is 
identified with a label (supplied) to indicate how the modem is configured (Base 
Station or Remote), plus the serial number and description of the modem. See 
Figure 2-2 for examples of modem labels. 
Each modem has an internal Electrically Erasable Programmable Read Only 
Memory (EEPROM) device to store the Base Station or Remote modem 
configuration data. 
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H1 BASE STATION H5
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Figure 2-1. Base Station and Remote Networks 

Base Station Modem

Serial Number
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Serial Number

Description

36893

BASE2

37253

BASE1

Remote Modem
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Serial Number
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36651
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Remote Modem

Serial Number

Description

Remote Modem

Serial Number

Description

36662

BASE2/H2

38311

BASE1/H1
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Figure 2-2. Examples of Modem Labels 
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Wireless modems have seven independent radio channels allowing seven separate 
Base Stations to operate in the same proximity without sharing a radio channel. 
The wireless modems have two modes of operation: Operating and Configuration. 
The procedures below place the modem into the Configuration mode, make the 
parameter selections, and then "launch" the modem back to the Operating mode. 
Whenever a modem is powered up, it is automatically placed into the Operating 
mode. A modem must be launched into the Operating mode before use with 
Wireless Logger for Windows. 

Connecting the Base Station Modem for Configuration 2-4. 
Complete the following procedure to configure a Base Station modem. Connect 
the modem to the Host Computer, as shown in Figure 2-3. All items, except for 
the Host Computer, are supplied with the Wireless Base Station Package (see 
Table 1-1). This procedure assumes the use of the Host Computer COM2 port. If 
COM1 is used instead of COM2, modify this procedure, as required. Before using 
COM3 or COM4, refer to "Connecting a Base Station" later in this chapter. 
1. Connect the wireless modem to be configured as a Base Station modem to the 

Host Computer COM2 port using the modem RS-232 cable and DB25-to-DB9 
adapter cable (if required). 

 The gender of the host computer COM port is always male. If you are trying 
to connect to a port that is female, it is not a COM port. 

2. Connect the modem power module into a source and connect the power output 
cable to the Base Station modem DC input. Verify that the modem PWR 
indicator is on (red) and not blinking. 

 If the PWR light is blinking, the modem failed self-test and cannot be used. 
Terminate this procedure and refer to "Modem Error Codes" in Chapter 6 
"Maintenance." 

 If the PWR indicator does not light, check the power connections. If the 
 connections are correct, either the power module or modem has failed. Repeat 
 with a different power module or modem to localize the problem. 
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12345678

HOST COMPUTER BACK PANEL

6–9 V DC

PWR

RD

CD

Base Station Modem

Serial Number

Description 36893PC1

Host-to-Modem Cable

Connect to  COM port.
Use DB25-to-DB9 adapter,
as required.

Modem Label

Modem being Configured

Modem Power Module.
Connect to 115V ac/60 Hz

source.

RS-232 connector (DB9).
Connect to Modem 

RS-232 Port.

Power connector.
Connect to Modem 
6–9V DC port.

 
rs024f.eps 

Figure 2-3. Connecting a Base Station (900 MHz) 

3. Assemble the antenna (see Figure 1-3) and connect it to the modem. Do not 
over tighten the connectors. 

4. Apply a Base Station Modem label on the modem (Figure 2-2). Fill in the 
unique serial number (bbbbb) as recorded on the bottom of the modem, and 
describe the Base Station (e.g., Host1, Base1, etc.). 
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Com Port Settings 2-5. 
1. Open Terminal Emulator from the Fluke Wireless Logger group of Program 

Manager or Hypen Terminal if in Windows �95 and if you receive a Select 
another port... message, COM2 is being used by another application. Close the 
other application and repeat this step. 

2. Open Communications... from the Settings menu. Verify or make the 
selections shown below (modify COM, as required). Click OK. 

 
rs025s.bmp 

900 MHz Base Station Modem Configuration 2-6. 
1. Press the ENABLE/RESET button on the modem (see Figure 1-3). Verify that 

the terminal screen displays the modem configuration MAIN MENU (on the 
next page). Note that b b b b b  is the Base Station modem serial number, and 
Radio Channel: 4 is the default. 

 If meaningless characters appear, the communication settings are incorrect. 
Go back to step 6. Note that the baud rate must be 9600 for modem 
configuration procedures. 

 If the MAIN MENU does not appear, check the cable connection. Verify that 
the modem is connected to the COM2 port. 
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 It is possible to have everything correct and not receive the modem 
configuration MAIN MENU if the COM2 port is internally redirected. For 
example, COM2 may be routed internally for a laptop computer 
communications modem disabling the external COM2 port. Other applications 
may make claim to COM2 such as a serial Mouse. When COM3 and COM4 
ports are installed, they often share interrupts with COM1 and COM2, causing 
a hardware conflict. Try another COM port or resolve the COM port issue and 
return to this procedure. 

 
rs026s.bmp 

 

2. Verify that the serial number at the top of the MAIN MENU matches the 
serial number you recorded on the modem Base Station Modem label. Menu 
selections are made in upper or lower case letters, e.g., R or r. To exit any 
menu at any time, press the <Esc> key. 
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3. D - Display Parameters. Type D and press <Enter>. This screen summarizes 
the present modem configuration. When the modem parameters are reset (next 
step), the screen appears as shown below. Press <Enter> to continue. 

 
rs027s.bmp 

 

4. R � Reset Parameters to Defaults. Type R and press <Enter>. Type Y and 
<Enter> in response to Reset to Default Settings? [Y or N]. 

 Note 
 The remainder of this procedure assumes the modem has been reset 

to the default settings. 
5. C � Change Radio Channel. Refer to the table below to select the radio 

channel for the Base Station. If you are setting up a single Base Station, radio 
channel 4 [default] has already been selected; continue to step 12. 

 Two or more Base Stations operating in the same proximity use different radio 
channels. For example, configure one Base Station modem for channel 2, and 
the second for channel 6. Using adjacent channels or a single channel for two 
networks may increase transmission errors. 
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 Type C and press <Enter>. Type the channel number and press <Enter> in 
 response to Enter Value [1-7]. 

 

 Radio Channel Number Selection 
  1 2 3 4 5 6 7 

 1    X    

 2  X    X  

Number 3 X   X   X 

of 4 X  X  X  X 

Base 5 X  X X X  X 

Stations 6 X X X  X X X 

 7 X X X X X X X 
Note: Reuse channels after seven networks have been used. 

 

6. N � Network Configuration. The default is correct. 
7. S � Serial Configuration. This sets up the wireless modem RS-232 port. 

Type S and press <Enter>. Complete the menu selections shown in bold. 

 B � Baud Rate (9600) 
  Set Baud Rate 
   Current Value: 9600 
   Enter Value [1=1200, 2=2400, 3=4800, 4=9600, 5=19200]: 5 <Enter> 
 

 E � Echo Mode (Simple) 
  Set Echo Mode 
   Current Value: Simple 
   Enter Value [(S)imple, (T)erminal or (N)one]: n <Enter> 

 

 F � Flow Control 
     FLOW CONTROL 
    X � Generate XON/XOFF (Disabled) 
    C � Generate CTS (Disabled) 
    D � Generate DSR (Disabled) 
    R � Recognize XON/XOFF (Disabled) 
    Enter Selection: <Esc> [defaults] 
 

 M � Maximum Line Length (256) 
  Maximum Line Length 
  Current Value: 256 
  Enter Value [1-576]: 300 <Enter> 
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 I � Input Time-out (Off) 
  Input Time-out 
  Current Value: Off 
  Enter Value [In 16ths of a second, 0 = Off]: <Esc> [default] 
 

 A � Add a Delimiter (13,10) 
  Delimiter to List 
   Current Value: 13,10 
   Enter Value [1-255]: <Esc> [default] 
 

 R � Remove a Delimiter (13, 10) 
  Remove Delimiter from List 
   Current Value: 13,10 
   Enter Value [1-255]: 13 <Enter> 
 

 R � Remove a Delimiter (10) 
  Remove Delimiter from List 
   Current Value: 10 
   Enter Value [1-255]: 10 <Enter> 
 
After the submenu selections above are complete, the S - Serial Configuration 
menu appears as shown below: Press <Esc> to return to the MAIN MENU. 

SERIAL PORT

  B – Baud Rate (19200)
  E – Echo Mode (None)
  F – Flow Control
  M – Maximum Line Length (300)
  I – Input Time-out (Off)
  A – Add a Delimiter (None)
  R – Remove a Delimiter (None)

 
rs115f.eps 
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8. A � Advanced Configuration. Type A and press <Enter>. Complete the 
menu selections shown below in bold. 

 B � Broadcast Address (1) 
  Set Broadcast Address 
   Current Value: 1 
   Enter Value [Positive Integer]: b b b b b  <Enter> [b b b b b  is the 
          Base modem 
          serial number 
          (from step 4)] 
 

 E � Enable Broadcast 
  Set Dest. to Broadcast? [Y or N] <Esc> [default] 
 

 D � Dest. Serial # (None) 
  Set Dest. Serial # 
   Current Value: Broadcast 
   Enter Value [From Serial # Label]: <Esc> [default] 
 

 C � Subchannel (1) 
  Set Subchannel 
   Current Value: 1 
   Enter Value [0-65535]: <Esc> [default] 
 

 S � Serial # Filter (None) 
  Set Incoming Serial # Filter 
   Current Value: None 
   Enter Value [From Serial # Label, 0 = None]: <Esc> [default] 
 

 T � Type Filter (None) 
  Set Incoming Type Filter 
   Current Value: None 
   Enter Value [(D)irected, (B)roadcast or (N)one]: B <Enter> 
 

 L � Lost Communication (Continue) [Toggles: Continue/Halt] 
  Enter Selection: [default] 
 

 O � Operating Mode (Pass-Through) [Toggles: Pass-Through/Packetized] 
  Enter Selection: O <Enter> 
 O � Operating Mode (Packetized) 
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After the submenu selections are complete, the A - Advanced Configuration menu 
appears as follows. Press <Esc> to return to the MAIN MENU. 

ADVANCED

 B – Broadcast Address (bbbbb)  [B. S. S/N]
 E – Enable Broadcast
 D – Dest. Serial # (None)
 C – Subchannel (1)
 S – Serial # Filter (None)
 T – Type Filter (Broadcast)
 L – Lost Communication (Continue)
 O – Operating Mode (Packetized)
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9. L - Launch Operating Mode. Launching reviews the selected parameters and 
places the modem into the Operating mode. 

 Type L and press <Enter>. The PARAMETER SETTINGS summary should 
agree with the figure shown below. Note that b b b b b  is the Base Station 
Modem Serial Number; the Radio Channel depends on your selection in step 
11; and the Radio Speed (121 KBaud) is not configurable. 

 Refer to Table 2-1 to find the menu for making corrections, as required. If the 
 parameters are correct, type Y and press <Enter> in response to Launch 
 Operating Mode? [Y or N]. 

 
rs028s.bmp 
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Table 2-1. Wireless Modem Parameters and Menus (900 MHz) 

Parameter Menu Location 

Serial Port  

 Operating Mode: Advanced Configuration/Operating Mode 

 Echo Mode: Serial Configuration/Echo Mode 

 Baud Rate: Serial Configuration/Baud Rate 

 XON/XOFF Generation: Serial Configuration/Flow Control 

 CTS Generation Serial Configuration/Flow Control 

 Delimiters: Serial Configuration/Add a Delimiter 

Serial Configuration/Remove a Delimiter 

 Max Length: Serial Configuration/Maximum Line Length 

 Input Time-Out: Serial Configuration/Input Time-Out 

 XON/XOFF Recognition: Serial Configuration/Flow Control 

 DSR Generation: Serial Configuration/Flow Control 

Network  

 Radio Channel: Main Menu/Change Radio Channel 

 Subchannel: Advanced Configuration/Subchannel 

 Dest. Serial #: Advanced Configuration/Dest. Serial # 

 Serial # Filter: Advanced Configuration/Serial # Filter 

 Radio Speed: [This is not a configurable parameter] 

 Broadcast Address: Advanced Configuration/Broadcast Address 

 Lost Communication: Advanced Configuration/Lost Communication 

 Type Filter: Advanced Configuration/Type Filter 

10. This completes the configuration of the Base Station modem. Choose one of 
the following: 

• Continue to the "Configuring a Remote Modem" procedure. 
• Select the Exit command from the File menu to exit the Terminal mode. Click 

No if there is a ... save the changes ... message. 
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2.4 GHz Base Station Modem Configuration 2-7. 
The base station�s modem is configured using the Terminal Emulator or 
Hyperterminal included in Microsoft Windows 3.1 and Windows 95. 
1. Start Terminal Emulator or Hyperterminal. 
2. Using a paperclip or similar device, press the modem�s �configure� button 

located on the modem�s front panel. This will bring up the modem�s main 
menu which appears as shown below. 

MAIN MENU

1) View configuration
2) Change configuration
3) Reset configuration to default
4) View event log
5) Resume operation

 
rs122f.eps 

 
3. Reset the modem to factory default settings by entering 3 <ENTER>, Y 

<ENTER>, then 2 <ENTER> to change configuration. 
4. Move to the Radio configuration menu by entering 1 <ENTER> and change 

the settings to match those shown below. 

RADIO SETTINGS

1) Node type (Master)
2) Domain (0)
3) Channel (1)
4) Subchannel (1)
5) Transmit count (Infinite)
6) Retry interval (1000 milliseconds)
7) Receive filter (None)
8) Destination address (Broadcast)
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5. Press <ENTER> to return to the modem configuration menu and select Serial 
port settings by entering 2 <ENTER>. Change the base station�s serial port 
settings to match those shown below. 

SERIAL PORT SETTINGS

1) Baud (19200)
2) Data bits (8)
3) Stop bits (1)
4) Parity (None)
5) Software XON/XOFF flow control (Disabled)
6) Hardware RTS/CTS flow control (Disabled)
7) Hardware DTR/DSR flow control (Disabled)

 
rs119f.eps 

 

6. Enter the Data Packet settings by entering 3 <ENTER> and change the 
settings to match the following: 

DATA PACKETING SETTINGS

1) Data mode (Packetized)
2) Line length (300)
3) Input timeout (10)
4) Delimiters (none)
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7. Return to the modem�s main menu and select item 5 �Resume Operation� to 
review and save the changes to the modem. The menu changes should match 
those shown below. If the changes are correct enter Y <ENTER> to save the 
current configuration. To make corrections to your settings, enter <ENTER>, 
and return to the main menu and make corrections as needed. 

Current Configuration

Radio:
Node type = Master Domain = 0

 Channel = 1 Subchannel = 1
Transmit Count = Infinite Retry interval = 1000 milliseconds

 Receive filter = None
 Destination address = N/A
Serial port:
 Baud = 19200
 Data bits = 8
 Stop bits = 1
 Parity = none
 Flow control = XON/XOFF: Disabled
Data packeting:
 Protocol = Packetized
 Line length = 300
 Input timeout = 10
 Delimiters = none

 
rs121f.eps 

Connecting the Remote Modem for Configuration 2-8. 
Complete the following procedure to configure a Remote modem. Connect the 
modem to the Host Computer for configuration, as shown in Figure 2-3. 
1. Connect the wireless modem to be configured as a Remote modem to the Host 

Computer COM2 port using the modem RS-232 cable. 
 The gender of the host computer COM port is always male. If you are trying 

to connect to a port that is female, it is not a COM port. 
2. Connect the modem power module into a power source and connect the power 

output cable to the Remote modem DC input. Verify that the modem PWR 
indicator is on (red) and does not blink. 

 If the PWR light is blinking, the modem failed self-test and cannot be used. 
Terminate this procedure and refer to "Modem Error Codes" in Chapter 6 
"Maintenance." 

 If the PWR indicator does not light, check the power connections. If the 
connections are correct, either the power module or modem has failed. Repeat 
with a different power module or modem to localize the problem. 
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3. Assemble the antenna (see Figure 1-3) and connect it to the modem. Do not 
over tighten the connectors. 

4. Apply a Remote Modem label on the modem (Figure 2-2). Fill in the unique 
serial number (r r r r r ) as recorded on the bottom of the modem, and describe 
the Remote (e.g., H1, Base1/H1, etc.). 

5. If you are already in the Terminal Emulator accessory, continue to step 7. 
Otherwise, open Terminal Emulator from the Fluke Wireless Logger group of 
Program Manager. 

 If you receive a Select another port... message, COM2 is being used by 
another application. Close the other application and repeat this step, or open 
Terminal directly from the Accessories group of Program Manager. 

6. Open Communications... from the Settings menu. Verify or make the 
selections shown below (modify COM, as required). Click OK. 

 
rs029s.bmp 
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900 MHz Remote Modem Configuration 2-9. 
1. Press the ENABLE/RESET button on the modem (see Figure 1-3). Verify that 

the terminal screen displays the modem configuration MAIN MENU (below). 
Note that r r r r r  is the Remote modem serial number, and Radio Channel: 4 is 
the default. 

 If meaningless characters appear, the communication settings are incorrect. 
Go back to step 6. Note that the baud rate must be 9600 for modem 
configuration procedures. 

 If the MAIN MENU display does not appear, check the cable connection. 
Verify that the modem is connected to the COM2 port. 

 It is possible to have everything correct and not receive the modem 
configuration menu if the COM2 port is internally redirected. For example, 
COM2 may be routed internally for a laptop computer communications 
modem disabling the external COM2 port. Other applications may make claim 
to COM2 such as a serial Mouse. When COM3 and COM4 ports are installed, 
they often share interrupts with COM1 and COM2, causing a hardware 
conflict. Try another COM port or resolve the COM port issue and return to 
this procedure. 

 
rs030s.bmp 
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2. Verify that the serial number at the top of the MAIN MENU matches the 
serial number you recorded on the Remote Modem label. Menu selections are 
made in upper or lower case letters, e.g., R or r. To exit any menu at any time, 
press the <Esc> key. 

3. D - Display Parameters. Type D and press <Enter>. This screen summarizes 
the present modem configuration. When the modem parameters are reset (next 
step), the screen appears as shown below. Press <Enter> to continue. 

 
rs031s.bmp 

 

4. R � Reset Parameters to Defaults. Type R and press <Enter>. Type Y and 
<Enter> in response to Reset to Default Settings? [Y or N]. 

 Note 
 The remainder of this procedure assumes the modem has been reset 

to the default settings. 
5. C � Change Radio Channel. Enter the identical radio channel used by the 

Base Station modem for this network. The default is channel 4. 
6. N � Network Configuration. The default is correct. 
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7. S � Serial Configuration. This sets up the parameters for the wireless modem 
RS-232 port. Type S and press <Enter>. Complete the menu selections shown 
below in bold. 

 B � Baud Rate (9600) 
  Set Baud Rate 
   Current Value: 9600 
   Enter Value [1=1200, 2=2400, 3=4800, 4=9600, 5=19200]:  <Esc> 
 

 E � Echo Mode (Simple) 
  Set Echo Mode 
   Current Value: Simple 
   Enter Value [(S)imple, (T)erminal or (N)one]: n <Enter> 
 

 F � Flow Control 
     FLOW CONTROL 
    X � Generate XON/XOFF (Disabled) 
    C � Generate CTS (Disabled) 
    D � Generate DSR (Disabled) 
    R � Recognize XON/XOFF (Disabled) 
    Enter Selection: x <Enter> <Esc> 
 

 M � Maximum Line Length (256) 
  Maximum Line Length 
  Current Value: 256 
  Enter Value [1-576]: 300 <Enter> 
 

 I � Input Time-out (Off) 
  Input Time-out 
  Current Value: Off 
  Enter Value [In 16ths of a second, 0 = Off]: <Esc> [default] 
 

 A � Add a Delimiter (13,10) 
  Delimiter to List 
   Current Value: 13,10 
   Enter Value [1-255]: <Esc> [default] 

 

 R � Remove a Delimiter (13, 10) 
  Remove Delimiter from List 
   Current Value: 13,10 
   Enter Value [1-255]: 13 <Enter> 
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After the submenu selections above are complete, the S - Serial Configuration 
menu appears as shown below. Press <Esc> to return to the MAIN MENU. 

SERIAL PORT

  B – Baud Rate (9600)
  E – Echo Mode (None)
  F – Flow Control
  M – Maximum Line Length (300)
  I – Input Time-out (Off)
  A – Add a Delimiter (10)
  R – Remove a Delimiter (10)
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8. A � Advanced Configuration. Type A and press <Enter>. Complete the 

menu selections shown in bold. 

 B � Broadcast Address (1) 
  Set Broadcast Address 
   Current Value: 1 
   Enter Value [Positive Integer]: b b b b b  <Enter> 
         [b b b b b  is the  
         associated Base 
         Station serial number, 
         not this modem serial 
         number] 
 

 E � Enable Broadcast 
  Set Dest. to Broadcast? [Y or N] y <Enter> 
 

 D � Dest. Serial # (Broadcast) 
  Set Dest. Serial # 
   Current Value: Broadcast 
   Enter Value [From Serial # Label]: <Esc> [default] 
 

 C � Subchannel (1) 
  Set Subchannel 
   Current Value: 1 
   Enter Value [0-65535]: <Esc> [default] 
 

 S � Serial # Filter (None) 
  Set Incoming Serial # Filter 
   Current Value: None 
   Enter Value [From Serial # Label, 0 = None]: b b b b b  <Enter> 
         [b b b b b  is the  
         associated Base 
         Station serial number, 
         not this modem serial 
         number] 
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 T � Type Filter (None) 
  Set Incoming Type Filter 
   Current Value: None 
   Enter Value [(D)irected, (B)roadcast or (N)one]: D <Enter> 
 

 L � Lost Communication (Continue) [Toggles: Continue/Halt] 
  Enter Selection: [default] 
 

 O � Operating Mode (Pass-Through) [Toggles: Pass-Through/Packetized] 
  Enter Selection: [default] 

 

After the submenu selections are complete, the A - Advanced Configuration menu 
appears as shown below: Press <Esc> to return to the MAIN MENU. 

ADVANCED

 B – Broadcast Address (bbbbb)  [B. S. S/N]
 E – Enable Broadcast
 D– Dest. Serial # (Broadcast)
 C– Subchannel (1)
 S – Serial # Filter (bbbbb)  [B. S. S/N]
 T – Type Filter (Directed)
 L – Lost Communication (Continue)
 O– Operating Mode (Pass-Through)

 
rs118f.eps 

 

9. L - Launch Operating Mode. Launching reviews the selected parameters and 
places the modem into the Operating mode. 

 Type L and press <Enter>. The PARAMETER SETTINGS summary should 
agree with the figure shown below. Note that r r r r r  is the Remote Modem 
Serial Number, b b b b b  is the associated Base Station Modem serial number; 
the Radio Channel matches the setting for the associated Base Station; and the 
Radio Speed (121 KBaud) is not configurable. 
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 Refer to Table 2-1 to find the menu for making corrections, as required. If the 
parameters are correct, type Y and press <Enter> in response to Launch 
Operating Mode? [Y or N]. 

 
rs032s.bmp 

 

10. The Remote modem is now configured for operation. Set the modem aside for 
use when completing "Connecting the Remotes," below. 

 Repeat this procedure for each Remote modem. All Remote modems 
associated with a particular Base Station are configured identically. Note that 
the remote modem serial number, r r r r r  (not used in this procedure) is used 
when configuring Wireless Logger for Windows software. 

 When the configuration of all the Remote modems is complete, select the Exit 
 command from the File menu to exit the Terminal Emulator accessory. Click 
 No if there is a ... save the changes ... message. 
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2.4 GHz Remote Modem Configuration 2-10. 
Now that the base station modem is configured, you need to configure the remote 
modem. Disconnect the base station modem from the PC and connect the remote 
modem to the PC. Be sure you do not confuse the two modems since they are 
configured differently. If you have not already done so, label the two modems 
Base Station and Remote with the labels included with the Wireless Logger. 
1. Start Terminal Emulator or Hyperterminal. 
2. Using a paperclip or similar device, press the modem�s �configure� button 

located on the modem�s front panel. This will bring up the modem�s main 
menu which appears as shown below. 

MAIN MENU

1) View configuration
2) Change configuration
3) Reset configuration to default
4) View event log
5) Resume operation
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3. Reset the modem to factory default settings by entering 3 <ENTER> Y 
<ENTER>. Then 2 <ENTER> to change configuration. Move to the Radio 
configuration menu by entering 1 <ENTER> and change the settings to match 
those in Figure 13. Take special note of menu selection #7 �Receive Filter� 
and #8 �Destination Address�. In these fields enter the serial number found on 
the underside of the base station modem. This will set the remote modem to 
listen and talk only with the base station modem. 

RADIO SETTINGS

1) Node type (Station)
2) Domain (0)
3) Channel (1)
4) Subchannel (1)
5) Transmit count (Infinite)
6) Retry interval (1000 milliseconds)
7) Receive filter (base station serial #)
8) Destination address (base station serial #)
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4. Press <ENTER> to return to the modem configuration menu and select serial 
port settings by entering 2 <ENTER>. Change the base station�s serial port 
settings to match those shown here. 

SERIAL PORT SETTINGS

1) Baud (9600)
2) Data bits (8)
3) Stop bits (1)
4) Parity (None)
5) Software XON/XOFF flow control(Generate)
6) Hardware RTS/CTS flow control(Disabled)
7) Hardware DTR/DSR flow control(Disabled)

 
rs125f.eps 

 

5. Enter the Data Packet settings by entering 3 <ENTER> and change the 
settings to match the following: 

DATA PACKETING SETTINGS

1)  Data mode (Passthrough)
2)  Line length (300)
3)  Input timeout (Infinite)
4)  Delimiters (1:10)
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6. Return to the modem�s main menu and select item 5 �Resume Operation� to 
review and save the changes to the modem. The menu changes should match 
those shown below. If the changes are correct enter Y <ENTER> to save the 
current configuration. To make corrections to the settings enter <ENTER>, 
and return to the main menu and make corrections as needed. 

Current Configuration

Radio:
Node type = Station Domain = 0

 Channel = 1 Subchannel = 1
 Transmit count = Infinite Retry interval = 1000 milliseconds
  Receive filter = (base station serial #)

 Destination address = (base station serial #)
Serial port:
 Baud = 9600
 Data bits = 8
 Stop bits = 1
 Parity = none
 Flow control = XON/XOFF: Generate
Data packeting:
 Protocol = Passthrough
 Line length = 300
 Input timeout = Infinite
 Delimiters = 10

 
rrs127f.eps 
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Connecting the Base Station for Operation 2-11. 
Complete the following procedure to connect a Base Station, as shown in 
Figure 2-3. This is the same connection used for configuring the modems. All 
items are supplied with the Wireless Base Station Package. (See Table 1-1.) This 
procedure assumes the use of the Host Computer COM2 port. If neither COM1 
nor COM2 are available, analyze the hardware configuration of the Host 
Computer for alternatives because COM3 and COM4 (if installed) often share 
interrupts with COM1 and COM2 and may not be suitable for connecting a Base 
Station. 
1. Connect the configured modem with the Base Station label to the Host 

Computer COM2 port using the modem RS-232 cable and DB9-to-DB9 
adapter cable. 

2. The gender of the host computer COM port is always male. If you are trying 
to connect to a port that is female, it is not a COM port. 

3. Connect the modem power module into a power source and connect the power 
output cable to the Base Station modem 6-9V DC input connector. Verify that 
the modem PWR indicator is on (red) and does not blink. 

 If the PWR light is blinking, the modem failed self-test and cannot be used. 
Terminate this procedure and refer to "Modem Error Codes" in Chapter 6 
"Maintenance." 

 If the PWR indicator does not light, check the power connections. If the 
connections are correct, either the power module or modem has failed. Repeat 
with a different power module or modem to localize the problem. 

4. Record the Base Station serial number and description inside the rear cover of 
this manual. 

5. Position the modem at least 1 foot (30 cm) away from adjacent objects, in 
particular, metal partitions. 
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Connecting the Remote for Operation 2-12. 
Complete the following procedure to connect a Remote, as shown in Figure 2-4. 
Use the items supplied with the Wireless Logger, or if converting an existing 
Hydra, use the items with the Hydra Conversion Kit (see Table 1-1). Repeat this 
procedure for each Remote. 
1. Position the components in the Hydra soft case, as shown in Figure 2-4. After 

the case is secured, it appears as shown in Figure 2-5. 
2. Connect the Remote modem to the Hydra using the short RS-232 cable. The 

modem should have a Remote Modem label with the modem serial number 
and description (e.g., H1). 

3. Connect the modem power module into a power source using the dual line 
cord and connect the power output cable to the Remote modem DC input 
connector. Verify that the modem PWR indicator is on (red) and does not 
blink. 

 If the PWR light is blinking, the modem failed self-test and cannot be used. 
Terminate this procedure and refer to "Modem Error Codes" in Chapter 6 
"Maintenance." 

 If the PWR indicator does not light, check the power connections. If the power 
connections are correct, either the power module or modem has failed. Repeat 
with a different power module or modem to localize the problem. 

4. Record the serial number and description of the Remote modem inside the 
rear cover of this manual. 

5. Connect the Hydra into a 115V ac/60 Hz power source using the other 
connector on the dual line cord. Apply power to the Hydra and configure the 
RS-232 communications port at the front panel by pressing the K key then 
the L key then press the up/down arrow keys and the E key to select 
9600 bAUd, no PAR, OFF CtS (2635A Data Bucket only), and OFF Echo. 
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Figure 2-4. Connecting a Remote 
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Figure 2-5. A Remote Ready for Placement 

Connecting a Local Hydra 2-13. 
Complete the following procedure to connect a Local Hydra, as shown in 
Figure 2-6. This procedure assumes the use of the Host Computer COM1 port. If 
COM1 is not available, analyze the hardware configuration of the Host Computer 
for alternatives because COM3 and COM4 (if installed) often share interrupts 
with COM1 and may not be suitable for connecting a Base Station. 
1. Connect the Hydra to the Host Computer COM1 port using the RS40 cable 

supplied in the 2625A/WL-700 Wireless Base Station Package. The cable has 
"RS40" stamped on the connectors. Use a DB25-to-DB9 adapter as required. 
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Figure 2-6. Connecting a Local Hydra 

2. Apply power to the Hydra and configure the RS-232 communications port at 
the front panel by pressing the K key then the L key, then the up/down 
arrow keys and the E key to select 9600 bAUd (19200 for the 2635A) , no 
PAR, OFF CtS (2635A only), and OFF Echo. 

Creating a Wireless Logger for Windows Setup File 2-14. 
Complete the following procedure to create a Wireless Logger for Windows setup 
file for the Base Station and Remote (and Local Hydra) communication 
parameters. The other segments of the setup file, including Hydra configurations, 
channel function, scan interval, alarms, scaling, etc., are discussed in Chapter 3 
"Using Wireless Logger for Windows." 
1. Position all the Remotes close to the Base Station, and connect the Local 

Hydra (if used). Power all Hydras and Remote modems. 
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2. Open Wireless Logger from the Fluke Wireless Logger group. The application 
opens to the Main Window (below). The top bar shows the name of the active 
setup file. When the application is first opened, the top bar reads Fluke 
Wireless Logger - [Untitled]. 

 
rs036s.tif 
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3. Save the current setup (default) to a file by selecting the Save Logger Setup 
As... command from the Setup menu. Type SETUP.STP for the file name and 
click OK. Verify the top bar changes to Fluke Wireless Logger - SETUP.STP. 

4. The default is one Hydra icon. Select the Create New Hydra command from 
the Setup menu if there is more than one Hydra for your setup. Repeat until 
the correct number of Hydra icons is displayed. 

5. Associate each Hydra icon (H1, H2, H3, etc.) with a Remote (and one icon 
with the Local Hydra, if used). Click the desired Hydra icon, then click the 
Edit Hydra Config... button to open the Hydra Configuration dialog box. Click 
the Communications... button to open the Communication Configuration 
dialog box. 

6. Establish if the Hydra being configured is the Local Hydra [RS-232] or a 
Remote Hydra [Wireless], then proceed to one of the following procedures. 
An example of setting the communication parameters for Hydra 1 as a Remote 
with serial number 36651 is shown below. 

  
rs037s.bmp 
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• Local Hydra � At the upper left, select Local Hydra (RS-232). In the 
Local Hydra (RS-232) group, select COM1 (if COM1 is not selected for 
the Local Hydra, see Chapter 2 "Connecting a Local Hydra"), 9600 Baud 
(19.2K Baud for the 2635A Data Bucket), and No Parity. 

• Remote Hydra �At the upper left corner, select Remote Hydra (Wireless). 
In the Address (Modem S/N): box of the Remote Modem group, enter the 
Remote modem serial number for the selected Hydra icon. In the Base 
Station Modem group, select COM2 (if COM2 is not selected for the Base 
Station modem, see Chapter 2 "Connecting the Base Station"), and 19.2K 
Baud. 

7. Click the Verify Connection button to test the communications between the 
Host Computer and the Hydra. 

8. A Connection Successful! return indicates that the communication parameters 
between the Base Station and Remote (or Local Hydra) are correct. Click OK 
in the dialog box and continue to step 8. 

9. A ! return and error message indicates that the communication parameters are 
not configured correctly, or that not all the connections have been made 
successfully. Click OK in the dialog box and go directly to the "Quick Check" 
paragraph below to resolve the problem. Do not continue with this procedure 
and do not close the dialog box. 

10. Click OK in the Communication Configuration menu and OK in the Hydra 
Configuration menu to return to the Main Window. If this is the last Hydra 
icon to configure, continue to step 9; otherwise, repeat steps 5 through 8 for 
each of the remaining Hydra icons. 

11. Select the Save Logger Setup command from the Setup menu to save the 
configuration parameters in the SETUP.STP file. 

Quick Check 2-15. 
Quick Check locates communication problems between the Base Station, 
Remotes, and Local Hydras when Verify Connection fails in step 7 of "Creating a 
Wireless Logger for Windows Setup File." When Verify Connection fails, a 
message box contains a message indicating the problem area. Refer to Table 2-3 
for suggestions when a communications difficulty occurs between the Base 
Station and a Remote. Refer to Table 2-4 for suggestions when a communications 
difficulty occurs between the Base Station and a Local Hydra. 
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Table 2-2. Quick Check and the Remote Hydra (Wireless) 

Dialog Box Message Comment Action 

Hydra n: Unable to 
initialize communications 
port! 

The COM port does not 
exist. 

Check the Host Computer for the 
COM port configuration and 
select a different COM port. 

The Host Computer COM 
port is not responding. 

The COM port is being 
used by other hardware or 
application, e.g., the 
Terminal accessory. 

Check what other applications are 
running or what hardware is 
currently active and clear the 
COM port for use with the 
Wireless Logger tool. 

Hydra n: Time-out waiting 
for Base Station Modem! 

The Base Station modem 
is not powered or has 
failed. 

The Base Station modem PWR 
light must be on and not blinking. 

The Host Computer is 
unable to communicate 
with the Base Station 
modem. 

The Base Station modem 
RS-232 parameters and 
the Host Computer RS-
232 parameters do not 
match. 

Check the RS-232 parameters for 
the Host Computer 
(Communications Configuration 
dialog box), and the Base Station 
modem using the modem 
configuration setup. 

 The Base Station modem 
is configured incorrectly, 
e.g., the Broadcast 
Address or Operation 
Mode. 

Use the modem configuration 
setup to check the Base Station 
modem parameters. 

 The Base Station modem 
has not been "launched" 
into the Operating mode. 

Remove and then apply power to 
the Base Station modem. 

 The RS-232 cable 
between the Host 
Computer and Base 
Station modem is 
defective. 

Use the supplied cable or other 
known good cable. In rare 
instances, a cable may fail. Try 
another cable. 

Hydra n: RS-232 
Communication Error! 

The Base Station modem 
configuration is incorrect. 

Check the Base Station modem 
parameters. 

 The Base Station modem 
is not powered. 

Apply power to the Base Station 
Modem. 

 The Base Station modem 
is not "launched." 

Remove modem power and then 
apply power to launch. 

There is an incompatibility 
in the Base Station 
modem setup. 

There is a hardware 
conflict for the COM port 
(internal modem, serial 
mouse, etc.). 

Resolve the hardware conflict to 
make the COM port fully 
available. 
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Table 2-2. Quick Check and the Remote Hydra (Wireless) (cont) 

Dialog Box Message Comment Action 

Hydra n: RF Transmission 
Failure! 

The Remote modem is not 
powered or has failed. 

The Remote modem PWR light 
must be on and not blinking. 

The Base Station 
transmitted but the 
Remote never responded. 

The Remote modem is 
configured for a different 
Base Station. 

The swapping of Remote 
modems between networks will 
not work. Each Remote modem is 
configured for a particular Base 
Station. 

 The Remote modem is 
configured incorrectly 
(wrong radio channel, 
operating mode, etc.). 

Use the modem configuration 
setup to check the Remote 
modem parameters. 

 The Remote modem is out 
of range. 

If the Remote is not adjacent to 
the Host Computer, bring the 
modem next to the Host to 
eliminate range as a factor in 
testing. 

Hydra n: Time-out waiting 
for Hydra! 

The Hydra power is off or 
has failed self-test. 

Power the Hydra and verify there 
are no error codes displayed 
during self-test. 

The Base Station modem 
was able to communicate 
with the Remote modem, 
but the Remote modem 
was unable to 
communicate with the 
Hydra. 

The Remote modem 
RS-232 parameters and 
the Hydra RS-232 
parameters do not match. 

Check the RS-232 parameters for 
the Hydra using the front panel 
K L and E keys, and 
the Remote modem using the 
modem configuration setup. They 
must match. 

 The Remote modem is 
configured incorrectly, 
e.g., the Broadcast 
Address or Operation 
Mode has the wrong 
selection. 

Use the modem configuration 
setup to check the Remote 
modem parameters. 

 The RS-232 cable 
between the Remote 
modem and the Hydra is 
defective. 

Use the supplied cable or other 
known good cable. In rare 
instances, a cable may fail. Try 
another cable. 

Hydra n: Unsupported 
model or version of Hydra! 

The Hydra is not a 2625A 
Data Logger or a 2635A 
Data Bucket. 

Connect the correct model Hydra. 
The 2625A must use software 
version 5.5 or higher (see Hydra 
Manual). 
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Table 2-3. Quick Check and the Local Hydra (RS-232) 

Dialog Box Message Comment Action 

Hydra n: Unable to 
initialize communications 
port! 

The COM port does not 
exist. 

Check the Host Computer for its 
COM port configuration and 
select a different COM port. 

The Host Computer COM 
port is not responding. 

The COM port is being 
used by other hardware or 
application, e.g., the 
Terminal accessory. 

Check what other applications are 
running or what hardware is 
currently active and clear the 
COM port for use with the 
Wireless Logger tool. 

Hydra n: RS-232 
Communication Error! 

Parity is selected in Local 
Hydra [RS-232], or the 
baud rate does not match. 

Other parity or baud selections 
cause RS-232 communication 
errors. 

The RS-232 parameters 
do not match those in the 
Communication 
Configuration dialog box. 

Host Computer may be 
running other applications 
using the same COM port. 

If COM1 and COM3/COM4 share 
an interrupt, errors may occur. 
Stop other applications to verify. 

 There is a hardware 
conflict for the COM port 
(internal modem, serial 
mouse, etc.). 

Resolve the hardware conflict to 
make the COM port fully 
available. 

Hydra n: Time-out waiting 
for Hydra! 

The Hydra is unpowered, 
failed self-test, or the RS-
232 cable is disconnected. 

Power Hydra, look for a self-test 
error display, or attach the RS-
232 cable. 

The Host Computer is 
unable to communicate 
with the Local Hydra. 

The Host Computer RS-
232 parameters and the 
Hydra RS-232 parameters 
do not match. 

Check the RS-232 Local Hydra 
(RS-232) parameters at the Host 
Computer; at the Hydra using 
K Land Ekeys. 

 Other applications are 
running and trying to use 
COM1 at the same time. 

Temporarily use COM2 (change 
Local Hydra (RS-232) settings) to 
verify. 

 Verify that Hydra is 
connected to the Host 
Computer COM1 port. 

Connection to COM3/COM4 may 
have interrupt conflicts. COM2 is 
reserved for wireless modem. 

Hydra n: Unsupported 
model or version of Hydra! 

The Hydra is not a 2625A 
Data Logger or a 2635A 
Data Bucket. 

Connect the correct model Hydra. 
The 2625A must use software 
version 5.5 or higher (see Hydra 
Manual). 
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Placing the Base Station and Remotes 2-16. 
After completing the procedure under "Creating a Wireless Logger for Windows 
Setup File," place the Remotes in their working locations, and position the Base 
Station. Observe the following guidelines: 
• Centrally Locate the Base Station. The nominal range for a non-line-of-sight 

Base Station/Remote communications link is 500 to 800 feet (150 to 240 
meters). Choose a Base Station location that is central to the Remotes for 
equal radio coverage, while not exceeding the 800 foot limit. 

• Avoid Radio Signal Barriers between the Base Station and Remotes. 
Avoid radio signal barriers such as metal partitions, concrete floors with metal 
reinforcing bars or metal pans. Line-of-sight communications is superior 
whenever possible. 

• Position the Remotes near a Source of Primary Power. Although both the 
Hydra and modem can operate from dc sources of power (9 to 12V dc for the 
Hydra, and 6.5 to 9.5V dc for the wireless modem) most installations involve 
connection to a 115V ac/60 Hz sources of power. Position the Hydra near a 
source of ac power whenever possible. 

• Position the Remotes near the Measurement Locations. The proximity of 
the Remote to the source of measurement inputs should be considered when 
placing the Remote. 

Using the Site Survey Feature to Verify Operations 2-17. 
The Site Survey feature of Wireless Logger for Windows verifies the 
communications path between the positioned Base Station and the located 
Remotes. This procedure assumes all Remotes are powered and have been 
successfully operated in close proximity to the Base Station before being placed in 
their operating location. 
Complete the following procedure to use Site Survey. 
1. Open Wireless Logger from the Fluke Wireless Logger group of Program 

Manager. 
2. Select the Load Logger Setup command from the Setup menu and enter the 

desired setup file, e.g., SETUP.STP. Click OK. 
3. Click the Hydra icon for the Remote to be verified. For example, Hydra/H1. If 

you are not using a mouse, press <Tab>, select the Hydra icon with the cursor 
keys, then press <Enter>. 
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4. Select the Site survey command from the Utilities menu, opening the 
following menu: 
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5. Click the Start button in the Site Survey dialog box. Communication between 
the Base Station and the selected Remote is indicated by the Successes count 
incrementing at approximately the same rate as the Totalizer Count. 
Occasional Failures are not unusual. 

 At the Hydra, press the O key and watch for a steadily increasing totalizer 
count. An occasional missing count is not unusual. 

 Frequent or steady Failures indicates poor communications between the Base 
Station and Remote. Reposition the Remote and/or the Base Station and repeat 
steps 3 through 5. 

 [Hint: Power the Remote with batteries to provide maximum Remote 
 portability. The Hydra connects to a 9 to 12V dc supply via a rear panel 
 connector. (See the Hydra manual.) The wireless modem connects to a 9V 
 dc supply using a standard 5.0mm outside-diameter/2.5mm inside-diameter 
 power plug. A Wireless Logger DC Power Kit to power the Hydra and 
 modem is available as an option. (See "Options and Accessories" in Chapter 
 1.) The absolute maximum dc input for the wireless modem is 9.5V DC.] 
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Connecting Hydra Analog and Digital Lines 2-18. 
Following the final positioning of the Remotes, connect the measurement lines, 
ALARM OUTPUTS, and DIGITAL I/O lines as described in the following Hydra 
manuals: 

• 2625A Hydra Data Logger. Hydra 2620A Series II Data Acquisition 
Unit/2625A Series II Data Logger Users Manual (Part Number 686675) 

• 2635A Hydra Data Bucket. Hydra 2635A Series II Data Bucket Users 
Manual (Part Number 686698) 
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Introduction 3-1. 
This chapter describes how to operate Wireless Logger for Windows. The 
operating procedures assume you have a working knowledge of Hydra parameters, 
described in the following Hydra manuals: 
• 2625A Hydra Data Logger. Hydra 2620A Series II Data Acquisition 

Unit/2625A Series II Data Logger Users Manual (Part Number 686675) 
• 2635A Hydra Data Bucket. Hydra 2635A Series II Data Bucket Users 

Manual (Part Number 686698) 
On-line Help also describes Hydra parameters and Wireless Logger for Windows 
features. To access Help, press the <F1> key at any time, or click any Help button. 
A summary of all Wireless Logger for Windows features and menus is provided in 
Chapter 4 "Wireless Logger for Windows Reference." 
This chapter assumes you have completed "Creating a Wireless Logger for 
Windows Setup File" in Chapter 2 and the Base Station and Remote network is 
operational. 
The following topics are covered in this chapter: 
• Hydra Configuration Procedures. How to enter, save, download, upload, 

and print Hydra configuration data. 
• Logging Operations. Starting and stopping the Hydras, using DDE, 

monitoring and optimizing performance, and using Site Survey. 
• Processing the Data. How to view, print, and process the data files in other 

applications. 
• Trend Plots. How to view the measurement trends during Hydra scanning, to 

save and print plots, and create Trend Plots from a data file. 

Starting and Stopping Wireless Logger for Windows 3-2. 
Similar to all Windows applications, Wireless Logger for Windows is started and 
exited using icons and menu selections. There are also several startup features that 
can be applied, allowing Wireless Logger for Windows to open automatically 
loading a setup file, and to open automatically loading a setup file and start all 
Hydras logging. 
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Starting Wireless Logger for Windows 3-3. 
To start Wireless Logger for Windows, open Wireless Logger from the Fluke 
Wireless Logger group of Program Manager. Verify Wireless Logger opens to the 
Main Window. 
To modify the starting procedure to open Wireless Logger for Windows 
automatically loading a setup file, conduct the following procedure. 
1. Select, but do not open, the Wireless Logger icon in the Fluke Wireless 

Logger group of Program Manager. 
2. Select the Properties... command from the File menu to open the Program Item 

Properties dialog box. 
3. Modify the Command Line displayed in the Program Item Properties dialog 

box by adding the setup filename after the WLOGGER.EXE command. For 
example, if the setup filename is SETUP.STP, the command line would 
change to WLOGGER.EXE SETUP.STP (see below). Click OK when the 
command line is correct. 
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The Command Line displayed in the Program Item Properties dialog box may be 
further modified to include the /G switch. Using the example above, the 
Command Line would change to WLOGGER.EXE SETUP.STP /G. The /G 
switch must follow the setup filename on the command line. 
The /G switch starts all Hydras when Wireless Logger for Windows is opened. 
Generally, this feature is used to automatically resume data collection after a loss 
of power to the Host Computer. For more information and configuration 
requirements when using the /G switch, refer to Appendix E, "Loss of Power." 

Exiting Wireless Logger for Windows 3-4. 
To exit Wireless Logger for Windows, select the Exit Application command from 
the Wireless Logger for Windows Setup menu, or double click the Control-Menu 
box (upper-left corner). 
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If you have changed the setup file, you will be prompted with a Save the changes? 
message, as shown below: 
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Click Yes to save the changes in the setup file and exit the application, click No to 
not save the changes in the setup file and exit the application, or click Cancel to 
return to the application. 

Hydra Configuration Procedures 3-5. 
Procedures in this section detail how to upload, download, save, and manipulate 
Hydra configuration data. 
The following topics are covered in this section: 
• Editing Hydra Configuration Data. Making changes to the Hydra 

configurations, e.g., scan interval, channel functions, alarms, Mx+B scaling, 
etc. 

• Copy Configuration Data Between Hydras. Copy any Hydra configuration 
to another Hydra. 

• Downloading Configuration Data to a Hydra. Sending the Hydra 
configuration from Wireless Logger for Windows to the Hydra. 

• Uploading Configuration Data from a Hydra. Sending the Hydra 
configuration from the Hydra to Wireless Logger for Windows. 

• Printing Configuration Data. Printing a hard copy record of the Hydra 
configuration data. 

Editing Hydra Configuration Data 3-6. 
Complete the following procedure to edit a Hydra configuration, which is saved in 
a setup file. 
1. Open Wireless Logger from the Fluke Wireless Logger group of Program 

Manager. Verify the Main Window is displayed, as shown below. 



Wireless Logger 
Users Manual 

3-6 
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2. Select the Load Logger Setup... command from the Setup menu (shown 
below). 
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Choose a setup file, e.g., setup1.stp, from the Load Setup File dialog box 
(shown below) as the destination for the Hydra configuration data. Click OK. 
If working with only the setup.stp file, choose it, and then immediately 
use the Save Logger Setup As... command to make a copy, e.g., 
setup1.stp. (Reminder: This procedure assumes you created a setup file 
with the communication parameters, as discussed in Chapter 2.) 
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Following the convention introduced in Chapter 2, the file setup.stp 
contains all the communication parameters, while copies (setup1.stp, etc.) 
will also include the Hydra configurations entered in this procedure. 
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3. In the Main Window, click on the desired Hydra icon, e.g., Hydra (H1). Click 
the Edit Hydra Config... button to open the Hydra Configuration dialog box 
(see below). 
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Make the following general selections in the Hydra Configuration dialog box 
to suit your application (click Help, as required): 
• Measurement Rate. Slow (high resolution) or Fast 
• Temperature Units. Celsius or Fahrenheit 
• Scan Parameters. Trigger Type, Hydra Scan Memory, Scan Interval 

(secs), and Wrap-Around Logging Mode. 
• Hydra Front Panel. Monitor Channel and Front Panel Lock. 
• Open Thermocouple Detect. Enable or disable. 
• Totalizer Debounce. Enable or disable. 
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4. Click the Channels... button to open the Channels Configuration dialog box 
(below). Configure this dialog box as described below. To configure multiple 
channels with the same configuration, select them using <Cntl>. 
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Click the Function... button to select the function of each Hydra channel. The 
Function Selection dialog box (following) is shown with an example. 
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The function selections are as follows. Click OK after making the selections. 
• Function. Select from OFF, VDC, VAC, OHMS-2T, OHMS-4T, 

THERMOCOUPLE, RTD-2W, RTD-4W, and FREQ. 
• Range. Select various ranges, depending on the Function. 
• Units Label. Select a units label to reflect the measurement. This feature 

is often used with Mx+B scaling (see below). 
Click the Mx+B... button to configure the selected channels for Mx+B scaling. 
The Mx+B dialog box is shown below. 
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• The Mx+B selections are as follows. Click OK after making the 
selections: 

• Mx+B Display Format. Pull down the menu and select the display 
format, which also dictates a maximum offset range. 

• Factor (M). Select a multiplier for the measurement from 
-0.000,000,000,000,000,1 to +99,999,999. 

• Offset (B). Select an offset for the measurement from -999,999,999 to 
+999,999,999. 

• Calculate Mx+B from Point Values. For automatic calculation and 
entering of the Mx+B values, plus the display format, click the Calculate 
Mx+B from Point Values... button. Enter the Input Range and Display 
Range values. Click OK. 

Click the Alarms... button to configure the selected channel(s) for alarm 
settings. The Alarms Configuration dialog box is shown below, with an 
example of HI and LO alarm settings. 
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• The Alarm selections (two alarms) are as follows. Click OK after making 
the selections. 

• Alarm State. Choose from HI (High), LO (Low) or OFF. 
• Alarm Value. Choose an alarm value consistent with the expected 

readings and alarm conditions. 
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• Digital Output. Associate a Hydra DIGITAL I/O line with an alarm 
output, less Channels 0 to 3, which have dedicated alarm outputs. When 
an alarm is active, the I/O line is set low. 

Select the Channel Label for each of the channels configured above by 
selecting the desired channel, entering the label and selecting the Apply Label 
button. Examples are shown below. 
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Click OK to return to the Hydra Configuration dialog box. 
5. Click the Data File... button to open the Data File Configuration dialog box, 

shown below, with an example. Each Hydra has a separate data file. 
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The Data File selections are as follows. Click OK after making the selections. 
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• Enable Data File Recording. Enable or disable. 
• Data File. Click the Select Data File... button and enter a file name, or if 

appending to a file, enter an existing file name. 
• File Comment. Enter a file comment, which appears in the data file 

header. (See "Processing the Data" later in this chapter.) 
• Scans to Skip Between File Recordings. Enter a number between 0 and 

65535 of scans to skip between file recordings. 
• Write to File When Alarms Active Only. Enable or disable. 
• Time Tag. Choose Absolute Time (secs), Date/Time String, or Elapsed 

Time (secs). 
• File Mode. Choose Append to File or Over-Write File. 

6. Click the Communications... button to open the Communications 
Configuration dialog box, shown below, with an example. 
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The Communication Configuration selections are as follows. Click OK after 
making the selections. 
• Local Hydra (RS-232)/Remote Hydra (Wireless). Click local or remote 

operation for the Hydra. 
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• Remote Modem. Enter the serial number of the Hydra Remote modem in 
the Address (Modem S/N) box. 

• Base Station Modem. Select the RS-232 port and Baud Rate of the Base 
Station COM port that connects to the Base Station wireless modem. 

• Local Hydra (RS-232). Select the RS-232 port, Baud Rate, and Parity for 
the RS-232 port that connects to the Local Hydra. 

• Verify Connection. Click to check the communications link. 
7. Click OK in the Hydra Configuration dialog box to return to the Main 

Window. The Main Window summarizes the configuration you just entered 
for the selected Hydra. To name the Hydra something other than Hydra 1, 
Hydra 2, etc., select the Describe Hydra... command from the Setup menu and 
edit the Hydra Name and/or Description. 

8. Select the Save Logger Setup command from the Setup menu to save the 
configuration data. 

 The configuration data does not automatically appear at the Hydra. The 
configuration is sent to the Hydra either at the start of logging (discussed in 
"Logging Operations") or when downloading (discussed in "Downloading 
Configuration Data to a Hydra"). 
Repeat steps 3 through 7 to configure each Hydra. 
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Copy Configuration Data Between Hydras 3-7. 
To copy a Hydra configuration to another Hydra, select the Copy Configuration.. 
command from the Setup menu. In the Copy Configuration dialog box, make 
From: and To: Hydra selections. Click Copy. All configuration parameters are 
copied except the data file configuration, communication configuration, and 
Hydra Name. The example below shows the Hydra 3 configuration will be copied 
to Hydra 1. 
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Downloading Configuration Data to a Hydra 3-8. 
The downloading feature sends configuration data from the Host Computer to a 
Hydra, configuring all the Hydra channels, alarms, Mx+B scaling, scan interval, 
etc. During logging operations, the default setting is for downloading to occur at 
the start of logging. 
Complete the following procedure to download configuration data to a Hydra. 
1. Click the Hydra icon in the Main Window for configuration data 

downloading. When downloading, it is this Hydra that receives the 
configuration data. If the displayed Hydra configuration is the configuration 
you want to download, proceed to Step 3; otherwise, continue to Step 2. 

2. Create the configuration you want to download using the procedures in 
"Entering Hydra Configuration Data" above, or copy a configuration from 
another Hydra using "Copy Configuration Data Between Hydras" above. 

3. Select the Download Hydra Config. command from the Utilities menu. 
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Uploading Configuration Data from a Hydra 3-9. 
The uploading feature retrieves configuration data from a Hydra, including all the 
channels, alarms, Mx+B scaling, scan interval, etc. (Note: Model 2635A using dc-
volt scales 90 mV and 900 mV uploads these scales as Auto.) 
Complete the following procedure to upload configuration data from a Hydra. 
1. Click the Hydra icon in the Main Window for configuration data uploading. 

When uploading, this Hydra provides the configuration data. 
2. Select Upload Hydra Config. from the Utilities menu (shown below). 
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3. Update channel labels and unit labels for the new uploaded configuration. 
4. To save this configuration, select the Save Logger Setup command from the 

Setup menu. 
5. To copy this configuration to another Hydra, refer to the previous heading 

"Copy Configuration Data Between Hydras." 

Printing Configuration Data 3-10. 
You can save Hydra configuration data as a text file, e.g., hydra1.txt. Like 
any text file, it can be opened in a word processing application or any text editor 
and then printed. 
Complete the following procedure to print a configuration data record. 
1. Click the Hydra icon in the Main Window for configuration data printing. 
2. Select the Save Hydra Config. Text... command from the Setup menu, opening 

the Save Hydra Configuration Text dialog box (see below). 
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1. Enter a text file name in the File Name box, e.g., hydra1.txt. Change the 
Directories, Drives, and Save File As Type, as desired. Click OK. 

2. Open the text file in any text editor or word processing application. 
3. To use the Windows Notepad Accessory, open Notepad from the Accessories 

group of Program Manager. Select the Open... command from the File menu. 
In the File Name box, enter the path and name of the text file saved in step 3 
above, for example, c:\wireless\hydra1.txt. Click OK. 

To print the file, select the Print command from the File menu. See the following 
printout example for the Hydra default settings.
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HYDRA1.TXT 
 
 
 
 
 
 
HYDRA CONFIGURATION - Hydra 1 
 
Hydra Name: Hydra 1 
Description: (None) 
Trigger Type: Interval Scanning 
Scan Interval: 5 sec 
Logging Mode: Wrap-Around 
Scan Memory: All Scans 
Communication: COM1 
Data File: None 
Scans Skipped: 0 
File Mode: Append 
Monitor Chan: None 
Front Panel Lock: Disable Locks 
Meas Rate: Slow 
Temp Units: Celsius 
OTC Detect: Yes 
Total Debounce: Yes 
 
Chan Function Range Alarm 1 Alarm 2 Mx+B Units Label 
0 OFF 
1 VDC 3V OFF OFF OFF VDC Ch1 label 
2 VDC 3V OFF OFF OFF VDC Ch2 label 
3 VDC 3V OFF OFF OFF VDC Ch3 label 
4 OFF 
5 OFF 
6 OFF 
7 OFF 
8 OFF 
9 OFF 
10 OFF 
11 OFF 
12 OFF 
13 OFF 
14 OFF 
15 OFF 
16 OFF 
17 OFF 
18 OFF 
19 OFF 
20 OFF 
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Logging Operations 3-11. 
Logging operations consist of synchronizing Hydra clocks, starting and stopping 
the Hydras, either as a group or individually, and monitoring the collection, 
display, and values of the measurement data. The information in this chapter 
assumes Hydras are configured and ready for use. (Refer to the information 
covered earlier under "Hydra Configuration Procedures.") 
Logging commands are in the Logging menu of the Main Window (see below). 
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Starting and Stopping the Hydras 3-12. 
Starting a Hydra begins the data collection, while stopping the Hydra ends data 
collection. Scan records are transferred from the Hydras to the Host Computer 
over the wireless modem link (or RS-232 cable for a Local Hydra). 
Complete the following procedure to start and stop the Hydras. 
1. Select the Synchronize Hydra Clocks command from the Logging menu. This 

synchronizes all the Hydra clocks with each other and to within one minute of 
the Host Computer system time. This is important for time tag data correlation 
in plotting and data processing. 

2. Select one of the following starting modes from the Logging menu: 
• Download Config. on Start [default]. Hydra configurations are sent from 

the Host to the Hydras when the Hydras are started. 
• Resume Logging on Start. Hydra configurations are retrieved from the 

Hydras when the Hydras are started, resuming operations. (Note: Model 
2635A using dc-volt scales 90 mV and 900 mV uploads these scales as 
Auto.) 

• Simulate Logging on Start. There is no Hydra activity. Instead, the 
software generates pseudo data for training and testing. 
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3. Click the Start Hydra button from the Main Window button bar, or, if starting 
all Hydras at once, the Start All Hydras command from the Logging menu. 
Verify the ...configuration... message below (assuming the default setting from 
step 2). If there are communication problems, an error message is reported. 
(See Appendix C "Error Messages.") 
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4. Verify the start of scanning with the Starting Hydra Logging message and a 
 change in the Hydra icon with the appending of LOG (below). 
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The Hydras are now collecting data. To stop scanning, proceed to step 5. 
If a Hydra being started holds old measurement data in its scan memory, a 
warning message is displayed (below) before logging is started. If you select Yes 
to continue, the measurement data will be cleared. To retrieve this data, select No 
and return to step 2. Select the Resume Logging on Start command and repeat 
steps 3 and 4. 
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5. Click the Stop Hydra button in the Main Window button bar, or, if stopping 
all Hydras at once, the Stop All Hydras command from the Logging menu. 
Verify the message Stopping Hydra Logging... 



 Using Wireless Logger for Windows 
 Logging Operations 3 
 

  3-21 

If the Hydra has measurement data remaining in scan memory, the Reading 
Remaining Hydra Scans... message appears (below). If you click the Abort 
button to terminate, the next time the Hydra is started using the Download 
Config. On Start mode, the warning message in step 4 appears. 
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Monitoring Performance 3-13. 
• The Options menu from the Main Window (below), provides performance 

monitoring options during logging. The options (discussed below) place a 
dialog window in the application. 
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• Show Current Readings. Displays the channel measurements and the Digital 
I/O status (decimal 0 to 255 for lines 7 to 0), the Alarm status (decimal 0 to 15 
for lines 3 to 0), and the Totalizer count for the selected Hydra. An example is 
shown below. 
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• Show Logging Status. Summarizes the communications link. Excessive 
Comm Errors indicate marginal communications between the Base Station 
and Remote. If the Scans In Hydra increase over time, scans are being 
collected in the Hydra faster than they can be retrieved. In this situation, stop 
logging and set the scan interval to a larger value. Enable Show Logging 
Status on Start from the Options menu [default] for automatic display when 
starting Hydra logging. 
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• Show Alarm Status. Summarizes the alarm status. The Alarm Bell appears 
when a channel is in alarm and all channels in alarm are listed. Enable Show 
Alarm Status on Alarm from the Options menu [default] for automatic display 
when a channel transitions into alarm. 
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• Configuration Lockout. This disables configuration-related commands in the 
Main Window Setup menu, including Create New Hydra, Delete Hydra, 
Describe Hydra..., Edit Hydra Configuration (including the button with the 
same function) and Copy Hydra Configuration... 

Optimizing Performance 3-14. 
The rate at which measurement data is transferred from the Remotes to the Base 
Station is optimized by the following: 
• Minimize the plot. When using the Trend Plot feature, minimize the plot 

window to an icon and bring the plot up only when viewing the data. (See 
"Starting and Stopping Trend Plots" step 3.) 

• Disable the "Screen Saver" feature. Automatic screen savers may slow 
system throughput. Disable them when possible. (See the Windows Control 
Panel.") 

• Disable Recording to Data Files. If you do not want to save data to a data 
file, be sure recording is disabled. (See "Editing Hydra Configuration Data," 
step 5.) 

• Save Only Alarm Data. Saving data only when a channel is in alarm [Model 
2625A only] increases system throughput as non-alarm data is not transferred. 
(See "Editing Hydra Configuration Data," step 5.) 

• Avoid Radio Channel Sharing. If networks share a single radio channel or 
adjacent channels, maximize the distance between the networks. Radio 
interference results in increased transmission errors, slowing down system 
throughput. (See "Configuring a Base Station Modem," step 11.) 

• Avoid Unnecessarily Short Scan Intervals. Short scan intervals increase the 
amount of measurement data for transfer over the communications link. To 
speed system throughput, choose the longest possible interval. (See "Editing 
Hydra Configuration Data," step 3.) 
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Simulated Logging 3-15. 
Simulated logging is enabled by selecting the Simulate Logging on Start command 
from the Logging menu. A Hydra that is logging in the simulated mode has SIM 
appearing in the icon (below). 
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Using Dynamic Data Exchange (DDE) 3-16. 
Dynamic Data Exchange (DDE) links Wireless Logger for Windows to other 
applications running under Windows. To use DDE, open the DDE client 
application and perform any setup necessary to access external data via DDE. 
Refer to Appendix D for information on DDE. 

Using Site Survey 3-17. 
The Site Survey feature is used to test the communications link between the Base 
Station and Remote through use of the Hydra Totalizer function. Refer to "Using 
the Site Survey Feature to Verify Operations" in Chapter 2. 

Processing the Data 3-18. 
Data files created during logging are saved in comma-separated-variable (csv) 
format in American Standard Code for Information Interchange (ASCII) text 
characters. Virtually all word processing, spreadsheet, and data management 
applications open, display, and print ASCII text files. 
To combine data files into a single file, or to "filter" data files for specific 
channels, measurement range, date/time, etc., refer to Chapter 5 "Pruning and 
Grafting Utility." Refer to Figure 3-1 for an example of the data file formatting. 
To process the data files, refer to one of the following topics: 
• Viewing and Printing Data Files. How to view and print the data files using  

the Windows Write Accessory. 
• Data Files and Other Applications. How to view and print the data files 

using other Windows applications, in particular, spreadsheets. 
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Setup
  Edit Hydra Config...

 Data File...
       Select Data File...
          File Name:

Internal Use

Date/Time File Created

Setup
  Edit Hydra Config...
    Data File...
       File Comment:

Always 1 Channel Unit String

Setup
  Edit Hydra Config...
     Channels...
       Function...
         Unit Label:

Date/Time of Scan Record

Readings:
Channel 1  Channel 2  Channel 3

"tempest.csv" "MAY2c./:"

"07/21/94 19:08:33"

"Kroon Temperature Test-Limit Testing"

1

"TIME", "OFF", "DEGREE", "DEGREES", "DEGREES", "OFF", "OFF",
"OFF", "OFF", "OFF", "OFF", "OFF", "OFF", "OFF", "OFF", "OFF", 
"OFF", "OFF", "OFF", "OFF", "OFF", "OFF", "TOTAL", "DIO"

"06/05/93 19:08:48", 0, +88.4613, +82.1185, +87.2038, 0, 0, 0, 
0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 4095

Undefined Channel
Readings (OFF)

Channel Unit String Scan Record String

Digital I/O Summary (12 Bits)

3 2 1 0 7 6 5 4 3 2 1 0

1 11 11 11 1 1 1 1 1 = 4095

Alarm
I/O

Digital
I/O

Note: Spacing between lines is enlarged for clarity.

Word
Wrap
Effect
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Figure 3-1. Data File Formatting 
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Viewing and Printing Data Files 3-19. 
You can view and print data files in their original csv format with the Windows 
Write or Notepad Accessory, or any word-processing application that opens text 
files. The procedure below assumes the use of the Write Accessory. The data is 
printed in strings, without formatting. Add your own formatting, as desired. 
1. Open Write from the Accessories group of Program Manager. 
2. Select the Open... command from the File menu. In the File Name box, enter 

the path and name of the desired data file, for example, 
c:\wireless\temptest.csv. Click OK. Select No Conversion is 
response to the "Do you want to convert this file to Write format?" to maintain 
this as a text file. 

3. Verify the text file appears in the format shown in Figure 3-1. 
4. To print the file, select the Print... command from the File menu. After 

printing or viewing, select the Exit command from the File menu. 

Data Files and Other Applications 3-20. 
Viewing and printing Wireless Logger for Windows data files is enhanced by 
processing the data in spreadsheet programs, which presents the data in columns. 
Spreadsheets can also present the data in graphs and plots. Complete the following 
procedure to view and print a data file in spreadsheet format. 
1. Open the spreadsheet application in Program Manager. 
2. There are two general methods for opening files. Select one of the methods 

below that suits your spreadsheet application. 
• Select the Open... command from the File menu. In the File Name box, 

type the complete path to the Wireless Logger for Windows data file you 
wish to display, for example, c:\wireless\temptest.csv. 

• Select the Import From command from the File menu. In the File Name 
box, type the complete path to the Wireless Logger for Windows data file 
you wish to display, for example, c:\wireless\temptest.csv. 

3. Adjust the spreadsheet column width and other formatting variables to display 
the data in the desired format. 
Print the data, as desired. (Refer to your spreadsheet documentation.) 

Trend Plots 3-21. 
Trend Plots provide a graphical indication of the measurement trend during Hydra 
scanning. Eight separate Trend Plot windows may be running at one time and each 
plot displays up to eight traces from any mix of Hydras and Hydra channels. An 
example is shown in Figure 3-2. Plot images may be saved using Windows 



 Using Wireless Logger for Windows 
 Trend Plots 3 
 

  3-27 

clipboard (*.clp) and Paintbrush (*.bmp) accessories, and pasted into any 
application that accepts images in bitmap format. Plots may be played back from a 
data file using other Windows applications such as a spreadsheet or plotting 
package. 
For customization of plot traces, line types include eight symbols, eight colors, 
and six line styles. 
The following topics are covered in this section: 
• Creating and Configuring a Plot. 
• Starting and Stopping Trend Plots. 
• Saving and Printing Trend Plots. 
• Getting the Right Trend Plot Look. 
• Deleting Trend Plots. 
• Creating Plots and Graphs from a Data File. 

Creating and Configuring a Plot 3-22. 
Complete the procedure below to create and configure a Trend Plot. A Trend Plot 
can be created at any time, even during data collection. 
1. Select the Plots menu from the Main Window. This opens a listing of the 

existing plots (eight plots maximum). The example below shows four plots, 
Plot 1 through Plot 4, already exist, and the plot created next will be Plot 5. 
Plot 1 through Plot 4 are the default plot titles. A plot title is assigned as 
shown in Figure 3-3. 
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About This Figure... 

The numeric display of readings is always from the most recent scan. The plot window Options... 
menu provides an option to show or hide the plot legend and readings. 

DIOWORD is the decimal equivalent of the status of the Hydra Digital I/O lines 7 to 0 (available at 
the Hydra rear panel DIGITAL I/O connector). If no lines are set, the I/O lines are 11111111 
(decimal 255). In this example, I/O lines 6 and 7 are grounded and I/O line 5 is connected to the 
contacts of a test toggle switch, toggling the I/O between 00111111 (63) and 00011111 (31). 

ALARMWORD is the decimal equivalent of the status of the Hydra dedicated Alarm lines 
(available at the Hydra rear panel ALARM OUTPUTS connector). When no alarms are set for 
channels 3 to 0 (the dedicated channels), the alarm lines are 1111 (decimal 15). In this example, 
Hydra 1, Channel 2, has a Low Alarm of 75° C. When Channel 2 reaches 75° C, the alarm lines 
change from 1111 (15) to 1011 (11). When the alarm clears, the lines return to 1111 (15). 

A channel in alarm displays measurements in red in the numerical display beneath the plot. Plots 
from Hydras with different scan intervals create traces with points closer together or farther apart 
on the plot. 

Figure 3-2. Typical Trend Plot 

2. Click on Create Plot to create a new plot. This creates a plot with default 
settings, as shown below. In this example, Plot 5 was created. 
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Customize the plot as shown by example in Figure 3-3. The readings in the legend 
appear only when the plot has been started. All selections, except for the channel 
label and units label, are made from the Plot window menus. After plots are titled, 
they might appear in the plot list as shown below. 
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Figure 3-3. Configuring a Trend Plot 
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Starting and Stopping Trend Plots 3-23. 
Complete the procedure below to start and stop a Trend Plot. Trend Plots operate 
independently from the Start Hydra and Stop Hydra commands made in the Main 
Window. When you start a Trend Plot, which always clears previous traces on the 
plot, it continues to run until you command it to stop. Trend Plots can be 
minimized to an icon by clicking the Minimize button (down arrow) in the top-
right corner of the plot window. Plot images can be captured at any time and 
printed out (see "Printing Trend Plots" below). 
1. Select the desired plot from the plot list in the Plots menu of the Main 

Window. 
2. At the top of the plots window, click Start! to start the plot. If a full-screen 

display is desired, click on the Maximize button (up arrow) at the top-right 
corner of the plot window. 

 You can turn the Show Symbols feature on and off at any time from the 
Options menu. Each symbol represents a data point, and data points are 
connected with the selected Line Type (see Figure 3-3). 

 To save the plot image at any time, select Copy Image from the Edit menu. 
This copies the plot into the Windows Clipboard (see "Printing Trend Plots" 
below). When the Edit menu is open, the plot pauses (no data is lost). 

 Data will not appear on the plot unless the Hydras associated with the plot 
channels have been started. The Hydras may be started before or after starting 
the plot. 

3. To close the plot, double click on the Control-menu box at the at the top-left 
corner of the plot window, or select Close Plot from the plot Setup menu. Any 
plotting that is in progress will continue. To completely remove a plot, you 
must use the Delete Plot command from the Plots menu of the Main Window. 

4. To retrieve a plot after it has been closed, select the plot title from the Plots 
menu of the Main Window. 

5. To stop a plot, retrieve the plot (see step 4) and click the Stop! button. 
 To save the plot image, click Edit and then Copy Image. This saves the plot in 

the Windows Clipboard. Be sure to process the graphic as soon as possible 
because any other use of the Clipboard overwrites the graphic. 

 If Start! is clicked again, the plot clears and begins. 
6. To clear the plot from the screen, select Close Plot from the plot Setup menu. 

Saving and Printing Trend Plots 3-24. 
The plot image in the Clipboard may be pasted immediately into another 
application or saved and recalled for processing at a later time. 
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Complete the procedure below to save, recall, and print a trend plot image using 
Windows. 

Saving a Trend Plot Image 3-25. 
1. While in a plot window, select Copy Image from the Edit menu. The plot 

image is saved in the Windows Clipboard feature. 
2. Open Clipboard Viewer from the Main group of Program Manager. 
3. Select Save As... from the File menu. In the File Name box, select a path and 

name, e.g., C:\WIRELESS\PLOT22.CLP. Click OK. 

Recalling a Trend Plot Image 3-26. 
1. Open Clipboard Viewer from the Main group of Program Manager. 
2. Select Open... from the File menu. In the File Name: box, select a path and 

name, e.g., C:\WIRELESS\PLOT22.CLP. Click OK. 
3. The recalled image in Clipboard may now be pasted into applications and 

accessories that accept graphics in bitmap format. 

Printing a Trend Plot Image 3-27. 
1. Place the desired Trend Plot image in the Clipboard (see above). 
2. Open Paintbrush from the Accessories group of Program Manager. 
3. Select Paste from the Edit menu. If the Paintbrush screen is too small for the 

paste, select the Image Attributes... command from the Options menu to resize 
the screen, then repaste the image. (See the Windows documentation for 
instructions on using Paintbrush.) 

 Trend Plot images can be enhanced using the Paintbrush tools. For example, 
adding text, grid lines, and comments. An example is shown in Figure 3-4. 

4. Select Print... from the File menu to print the image. 
5. To save the image, select Save As... from the File menu. Select a path and 

name, e.g., C:\WIRELESS\PLOT22.BMP. Click OK. 
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Getting the Right Trend Plot Look 3-28. 
A Trend Plot data point is connected to the next data point with the selected Line 
Type, and marked with a Symbol (if selected) (see Figure 3-3). There are eight 
different symbols, one for each of the eight plot traces (below). 
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When a Trend Plot time span is selected in the Plot Settings dialog box, the 
minimum Hydra Scan Interval for a full-scale plot is calculated and displayed (see 
below). For example, a plot time span of 10 hours calculates a minimum 
recommended Hydra scan interval of 73 seconds. Typical plot characteristics are 
shown in Figures 3-5 and 3-6. 
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Original Trend Plot Image 
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Enhanced Trend Plot Image Using the Paintbrush Accessory 
Figure 3-4. Printing Trend Plots 
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Figure 3-5. Trend Plot Characteristics 
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Figure 3-6. Troubleshooting Trend Plots 
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Deleting Trend Plots 3-29. 
Complete the procedure below to delete a Trend Plot. 
1. Select the Delete Plot command from the Plots menu of the Main Window. 
2. Select the title of the plot to delete, then click Delete (see below). Respond to 
 the Delete Anyway? message with OK. Repeat for each plot to be deleted. 
3. Click on Close to return to the Main Window. 
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Creating Plots and Graphs from a Data File 3-30. 
You can create a plot or graph of a data file by using most spreadsheet 
applications. The procedure that follows is general and should be adapted to 
whatever spreadsheet program you are using. 
Complete the following procedure to create a plot or graph from a data file. 
1. Open the spreadsheet application from Program Manager. 
2. There are two general methods for opening files. Select one of the methods 

below that suits your spreadsheet application. 
• Select the Open... command from the File menu. In the File Name box, 

type the complete path to the Wireless Logger for Windows data file you 
wish to display, for example, c:\wireless\temptest.csv. 

• Select the Import From command from the File menu. In the File Name 
box, type the complete path to the Wireless Logger for Windows data file 
you wish to display, for example, c:\wireless\temptest.csv. 

3. Adjust the spreadsheet column width and other formatting variables to display 
the data in the desired format. 

4. Highlight the cells you wish to plot or graph. Include the far-left column 
containing Hydra time stamps to plot data versus time. 

5. From the spreadsheet toolbar or menu, open the graph/plot utility. 
6. Open a plot/graph window in the spreadsheet to display the plot/graph. 
7. Select the desired plot or graph format, and enter titles, axis labels and other 

formatting features, as desired. 
8. Print the plot/graph from the spreadsheet or copy and paste it into word 

processing, Paintbrush accessory, Clipboard accessory, or any application that 
accepts images in bitmap format. 



  4-1 

Chapter 4 
Wireless Logger for Windows 

Reference  

Contents Page 

4-1. Introduction........................................................................................... 4-3 
4-2. Main Window ....................................................................................... 4-3 
4-3. Setup Hydra Configuration................................................................... 4-4 
4-4. Create New Hydra ............................................................................ 4-5 
4-5. Delete Hydra..................................................................................... 4-5 
4-6. Describe Hydra................................................................................. 4-5 
4-7. Edit Hydra Configuration................................................................. 4-6 
4-8. Copy Hydra Configuration ............................................................... 4-15 
4-9. Save Hydra Configuration Text ....................................................... 4-15 
4-10. Load Logger Setup ........................................................................... 4-15 
4-11. Save Logger Setup............................................................................ 4-16 
4-12. Save Logger Setup As ...................................................................... 4-16 
4-13. Exit Application ............................................................................... 4-16 
4-14. Logging................................................................................................. 4-16 
4-15. Synchronize Hydra Clocks ............................................................... 4-17 
4-16. Start All Hydras................................................................................ 4-17 
4-17. Stop All Hydras ................................................................................ 4-17 
4-18. Start Hydra ....................................................................................... 4-17 
4-19. Stop Hydra........................................................................................ 4-18 
4-20. Download Configuration on Start .................................................... 4-18 
4-21. Resume Logging on Start ................................................................. 4-18 
4-22. Simulate Logging on Start................................................................ 4-18 
4-23. Plots ...................................................................................................... 4-18 
4-24. Create Plot ........................................................................................ 4-19 
4-25. Delete Plot ........................................................................................ 4-19 
4-26. 1 Plot 1, 2 Plot 2, etc. ....................................................................... 4-19 



Wireless Logger 
Users Manual 

4-2 

4-27. Utilities .................................................................................................  4-19 
4-28. Perform Site Survey... ......................................................................  4-20 
4-29. Download Hydra Configuration ......................................................  4-20 
4-30. Upload Hydra Configuration ...........................................................  4-21 
4-31. Options .................................................................................................  4-21 
4-32. Show Current Readings ...................................................................  4-21 
4-33. Show Logging Status .......................................................................  4-22 
4-34. Show Alarm Status ..........................................................................  4-22 
4-35. Show Logging Status on Start..........................................................  4-22 
4-36. Show Alarm Status on Alarm ..........................................................  4-22 
4-37. Configuration Lockout.....................................................................  4-23 
4-38. Help ......................................................................................................  4-23 



 Wireless Logger for Windows Reference 
 Introduction 4 
 

  4-3 

Introduction 4-1. 
This chapter is a reference guide to the dialog boxes and menus of Wireless 
Logger for Windows software. Each dialog box contains various types of controls 
for performing functions, selecting parameters, and entering file names. Press the 
F1-Help key, or select the Help button in the current dialog box for specific 
information about an operation. 

Main Window 4-2. 
The Main Window (below) is displayed whenever the Wireless Logger for 
Windows application is selected from the Windows Program Manager. The Main 
Window provides a menu bar at the top, buttons for quick access to three often-
used Main Window items, a Hydra selection menu bar just below the buttons, and 
a Hydra configuration display area. 
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The menu bar across the top of the Main Window allows you to select Wireless 
Logger for Windows menu commands for setting up the Hydra configuration, 
starting scanning and data collection, setting up trend plots, uploading and 
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downloading Hydra configuration, showing status windows, locking out 
configuration changes, and displaying help. 
To speed operations, the button bar (located below the menu bar) contains three 
commonly selected functions. These functions allow you to quickly edit the Hydra 
configuration, and start and stop the selected Hydra. 
The Hydra selection icon bar contains an icon for each Hydra created using the 
Create New Hydra command from the Setup menu. The selected Hydra is 
highlighted. The information contained in the Hydra configuration display area 
applies to the selected Hydra in the icon bar. Any parameters that are set using the 
menu bar and the button bar apply to the selected Hydra. 
The Hydra configuration display summarizes the Hydra configuration associated 
with the Hydra that is selected in the Hydra-selection icon bar. To change any of 
the configuration parameters shown, use the menus and dialog boxes provided in 
the main menu bar and the button bar. Select the Describe Hydra... command from 
the Setup menu to change the name and description of the selected Hydra. Use the 
Hydra Configuration dialog box (Setup Edit Hydra Config... menu or the Edit 
Hydra Config... button) to change the settings for Trigger Type, Scan Interval, 
Logging Mode, Scan Memory, Monitor Chan, Front Panel Lock, Meas Rate, 
Temp Units, OTC Detect, and Total Debounce. Use the Communication 
Configuration dialog box (Setup Edit Hydra Config... Communication...) to 
change the Communication parameters. Use the Data File Configuration dialog 
box (Setup Edit Hydra Config... Data File...) to change the settings for Data File, 
Scans Skipped, and File Mode. Use the Channels Configuration dialog box (Setup 
Edit Hydra Config... Channels) to set the channel definitions (the channels are 
shown at the bottom of the Hydra configuration display area). The contents of the 
menus and dialog boxes of the menu system are described in the following 
paragraphs. 

Setup Hydra Configuration 4-3. 
The Setup menu (below) contains commands to create new Hydras in the Main 
Window, delete Hydras from the Main Window, describe the Hydra, edit the 
configurations of each of the attached Hydras, and copy and save various 
configurations and setups. All configuration related dialog boxes include the 
associated Hydra number in the caption of the dialog, for example �Channel 
Configuration (Hydra 1).� All menu command followed by "..." open dialog 
boxes. 
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Create New Hydra 4-4. 
This menu selection adds a new Hydra icon to the Hydra selection menu bar. A 
default configuration is associated with the new Hydra icon, and is displayed in 
the Hydra configuration display area of the Main Window. 

Delete Hydra 4-5. 
This menu selection deletes the selected Hydra from the Hydra selection menu 
bar. The associated Hydra configuration is also deleted. A warning message 
appears that gives you a chance to cancel the deletion. 

Describe Hydra  4-6. 
This menu selection opens a dialog box (below) for entry of a Hydra name and 
description. Click OK to place the Hydra name and description in the Hydra 
configuration display area of the Main Window. 
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Edit Hydra Configuration 4-7. 
This menu selection opens a dialog box (below) that allows you to enter the 
configuration parameters for the selected Hydra, establish the communications 
parameters between the Hydras and the base station, select the channel 
configurations for the Hydra, and enable data recording. 
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The changes made to the parameters are shown in the Hydra configuration display 
area of the Main Window. The Hydra configuration is downloaded to the selected 
Hydra when the Hydra is started (using the Download Config. on Start starting 
mode). 
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The following items are included in the Hydra Configuration dialog box: 
• Measurement Rate. The speed at which the Hydra measures the input of 

each channel. The slow measurement rate provides the highest accuracy and 
resolution. The fast rate provides one less digit of resolution. 

• Temperature Units. The type of temperature reading taken on the Hydra. The 
displayed temperature unit can either be degrees Celsius (°C) or Fahrenheit 
(°F). 

• Scan Parameters. Sets the method the selected Hydra uses to scan its 
channels. 

• Hydra Front Panel. Sets the attributes of the front panel of the selected 
Hydra. 

• Open Thermocouple Detection. If checked, the open thermocouple detection 
circuitry on the Hydra is enabled. Disable open thermocouple detection if you 
have other instrumentation measuring the same thermocouple terminal. 

• Totalizer Debounce. If checked, input debouncing is enabled for the �Σ� 
input on the rear panel Digital I/O connector, which adds a delay of 1.75 ms to 
each transition, allowing increased accuracy from totalizer inputs from contact 
closures. 

The available Scan Parameters (below) include the following: 
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• Trigger Type � Interval Scanning. Interval Scanning controls the scan 
trigger by scan interval. The resolution of interval scanning is 1-second (up to 
9 hours, 99 minutes, and 99 seconds). 
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• Trigger Type � Interval + External. Interval + External allows an external 
source to initiate a single scan. If a scan is already in progress, this request is 
ignored. 

• Trigger Type � Interval + Monitor Alarm. Interval + Monitor Alarm allows 
an alarm condition on the monitor channel to trigger a single scan. If a scan is 
already in progress, this request is ignored. 

• Trigger Type � External. External allows an external source to initiate 
scanning. If a scan is already in progress, this request is ignored. 

• Trigger Type � Monitor Alarm. Monitor Alarm allows an alarm condition 
on the monitor channel to trigger scanning. If a scan is already in progress, 
this request is ignored. 

External enables scanning when a low input occurs on the rear-panel TR terminal 
of the Hydra. 
Monitor Alarm triggers a scan when an alarm condition occurs on the monitor 
channel. External triggering is disabled. 
• Hydra Scan Memory (below). Establishes what types of scans are saved in 

the internal Hydra scan memory. If you select All scans, all of the scans of all 
channels on the Hydra (except those whose function is set to OFF) are 
recorded into the scan memory. If you select Alarms Only, only those scans 
that occur while one or more channels are in alarm are recorded [Model 
2625A only]. If you select Alarm Transitions Only, only the single scan that 
occurs when a channel transitions into alarm and the single scan that occurs 
when a channel transitions out of alarm are recorded [Model 2625A only]. 
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• Scan Interval. Sets the period between starts of measurement scans. The scan 
interval has a resolution of 1 second. The maximum scan interval is 38439 
seconds. 

• Wrap Around Logging Mode. Establishes whether the Hydra stops 
recording data in internal Hydra scan memory once the memory is full, or 
continues to record data overwriting the oldest data in scan memory. To stop 
recording once memory is full, remove the check from the check box. To 
continue recording data after memory is full, check this selection. 

• The Front Panel items include: 
• Monitor Channel (below). Establishes which channel is displayed on the 

front panel of the Hydra during logging. Runs the monitor function on the 
selected channel. The selection includes channels 0 through 20, or �None� if 
no channel is to be displayed. 
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• Front Panel Lock (below). Enables or disables special Hydra lockout modes. 
If the Front Panel Lock is set to Review Lock, all keys are disabled except the 
up/down and left/right arrow keys for review of the minimum, maximum, and 
last values of any channel. If set to Monitor Lock, all keys are disabled except 
the up/down arrow keys for monitoring any channel. If set to Disable Locks, 
all key functions on the Hydra are disabled. 
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The following buttons in this dialog box open the next level of dialog boxes: 
• Communication... 
• Channels... 
• Data File... 

Communication... 
The Communication Configuration dialog box (below) sets up the 
communications link between the Base Station and Remote Hydra, or the Local 
Hydra. 
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If you select the Local Hydra (RS-232) option button, the Local Hydra 
information is enabled. Select the RS-232 Port number for the Local Hydra, and 
set the baud rate and parity for the selected port. 
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If you select the Remote Hydra (Wireless) option button, the Wireless Logger 
information is enabled. Enter the address of the remote Wireless modem (the 
serial number located on the modem label). Select the RS-232 Port number on 
which the Base Station Wireless modem is connected, and set the baud rate for the 
selected port. 
To test the communications you have set up, click the Verify Connection button. 
If an error occurs, a diagnostic error message is displayed. (See Appendix C 
"Error Messages." 

Channels... 
The Channel Configuration dialog box (below) changes the configuration of a 
selected group of channels on the Hydra. Use the mouse cursor to select the 
channel(s) you want to change. 
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Use the following buttons to change the configuration of the channel(s): 
• Function... 
• Mx+B... 
• Alarms... 
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To change the label of the selected channel(s), enter the new label in the Channel 
Label edit box, then click the Apply Label button. If you select more than one 
channel, the labels of all the selected channels are changed. 

Function... 
The Function Selection dialog box changes the function configuration of selected 
Hydra channels. 
Select the function you want the channel to perform by using the Function drop-
down box. 
Use the Range drop-down box to change the range of the function. 
Use the RTD R0 edit box to enter the resistance of the RTD at the freezing point 
(Fahrenheit or Celsius). 
Use the Units Label edit box to select the units displayed for the selected Hydra 
channel. 

Mx+B... 
The Mx+B Configuration dialog box selects the factor, offset, and display format 
of an Mx+B measurement for scaled readings on the selected channel of the 
Hydra. 
Use the Mx+B Display Format drop-down box to select the format of the readings 
output by the Hydra. 
Use the Factor (M) and Offset (B) edit boxes to select the M and B scaling values. 
Use the Calculate Mx+B from Point Values button to open the Mx+B Calculation 
dialog box. This dialog box automatically calculates the Factor (M), Offset (B), 
and display format values. Enter the minimum and maximum values of the input 
you are using on the selected channel of the Hydra. Enter the minimum and 
maximum of the output from the Hydra. Click OK to exit the Mx+B Calculation 
dialog box and place the Mx+B values into the Mx+B Configuration dialog box. 

Alarms... 
The Alarms Configuration dialog box sets the configuration for the two available 
alarms for the selected channel on the Hydra. 
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Use the Alarm State drop-down box to set the alarm to either OFF for no alarms, 
LO for alarms to occur below a certain limit, and HI for alarms to occur above a 
certain limit. 
Use the Alarm Value edit box to set the value at which the alarm is activated. 
Use the Digital Output drop-down box to associate alarms for channels 4 though 
20 with the rear panel DIGITAL I/O lines of the Hydra. Channels 4 through 20 
can be associated with any one or combination of the DIGITAL I/O pins. Note 
that alarms occurring on channels 0 through 3 are always associated with the rear 
panel ALARM OUTPUTS (channel 0 to ALARM OUTPUT 0, channel 1 to 
ALARM OUTPUT 1, etc.). 

Data File... 
The Data File Configuration dialog box (below) enables or disables data file 
recording of Hydra scan data and set data file parameters. 
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To enable data file recording, check the Enable Data File Recording check box. 
To disable data file recording, remove the check from the Enable Data File 
Recording check box. All other boxes in the dialog box are disabled, but the 
information contained in them is retained. 
Click the Select Data File button to select the name of the data file. 
Use the File Comment edit box to enter a comment to be placed in the data file 
heading. 
Use the Scans to Skip Between File Recordings edit box to select how many scans 
you want to skip between recordings to the data file. For example, if you select 0, 
all scans are recorded in the data file. If you select 1, every other scan is recorded. 
To write to the data file only when an alarm occurs, check the Write to File When 
Alarms Active Only check box. 
Time Tag sets the format of the time stamp that is recorded at the beginning of 
each record in the data file. Three types of time stamp can be recorded: 
• Absolute Time (secs). Absolute time is the number of seconds since January 

1, 1970 at 00:00:00 Universal Coordinated Time (UCT). 
• Date/Time String. Date/Time String shows the time as a string consisting of 

the month, day, and year, along with the hour, minutes, and seconds. 
• Elapsed Time (secs). Elapsed Time shows the time as the number of seconds 

since the time of the first scan entered into the data file. 
The File Mode box lets you select how to write to the data file. To append data to 
an already existing file, select the Append to File option button. To always 
overwrite the file at the start of a logging run, select the Over-Write File option 
button. 
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Copy Hydra Configuration 4-8. 
The Copy Configuration dialog box (below) copies the configuration from one 
Hydra to another. Select the Hydra you want to copy the configuration from in the 
From list box. Select the Hydra you want to copy the configuration to in the To 
list box. Then click the Copy button. Communication and data file parameters and 
the Hydra name are not copied. 
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Save Hydra Configuration Text 4-9. 
The Save Hydra Configuration Text dialog box allows you to save the Hydra 
configuration to a text file. The text is written to the file in a form similar to that 
of the display in the Main Window. The configuration information from this file is 
for documentation purposes only and cannot be loaded into the Wireless Logger 
for Windows application. 

Load Logger Setup 4-10. 
The Load Setup File dialog box allows you to select a setup file from which the 
overall logger setup is to be loaded. The logger setup includes the trend plot 
configurations. To retrieve a plot after loading a setup, select the plot title from 
the plot list in the Plots menu. 
The Wireless Logger for Windows application also accepts the logger setup 
filename as a command line argument when the application is started up. 
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Save Logger Setup 4-11. 
This menu selection saves the current overall logger setup into the setup file last 
loaded from or saved to. If no such file exists, this menu selection opens a dialog 
box that lets you select a setup filename. 

Save Logger Setup As 4-12. 
The Save Logger Setup As dialog box lets you save the current overall logger 
setup into a file with a filename you select. 

Exit Application 4-13. 
This menu selection closes the Wireless Logger for Windows application and all 
associated trend plots. If changes have been made to the overall setup and have 
not been saved, you are asked whether you want to save the changes. 

Logging 4-14. 
The Logging menu (below) contains the following selections for starting and 
stopping logging activity, and for specifying how to start logging: 
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• Synchronize Hydra Clocks 
• Start All Hydras 
• Stop All Hydras 
• Start Hydra (duplicated as a button in the Main Window) 
• Stop Hydra (duplicated as a button in the Main Window) 
• Download Config. on Start 
• Resume Logging on Start 
• Simulate Logging on Start 
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After a Hydra has been started, its associated icon in the Hydra Selection menu 
bar is modified to indicate logging status. The appearance of the icon is different 
for normal logging and for simulated logging. 
Certain menu functions are not available during logging and are disabled. These 
functions include Hydra configuration changes and any actions that involve 
communicating with the Hydra. 

Synchronize Hydra Clocks 4-15. 
This command sets all Hydras to the same date and time. Since Wireless Logger 
for Windows supports versions of Hydra that only allow times to be set with one 
minute resolution, the times set in the Hydras may be off by up to one minute from 
the PC system time, but are synchronized with respect to each other. This 
command is very important for correlating data from multiple Hydras in plotting 
and data processing. 

Start All Hydras 4-16. 
This command initiates data collection from all Hydras not already in data 
collection mode. If starting in the Download Config. on Start mode and a Hydra 
has scans in its logging memory, a warning message appears, giving you the 
option to cancel. If you continue, logging memory is cleared. If initiation of data 
collection for any Hydra fails, an error message is displayed, and the command is 
aborted. 
�All Hydras� refers to the Hydras appearing in the Hydra selection menu bar. 

Stop All Hydras 4-17. 
This command stops data collection from all Hydras. If scans remain in any Hydra 
after scanning has been stopped, the remaining scans are read (to abort reading the 
scans, click the Abort button). �All Hydras� refers to the Hydras appearing in the 
Hydra selection icon bar. 

Start Hydra 4-18. 
This command initiates data collection from the selected Hydra. If starting in the 
Download Config. on Start mode and if the Hydra has scans in its logging 
memory, a warning message appears, giving you the option to cancel. If you 
continue, logging memory is cleared. If initiation of data collection fails, an error 
message is displayed. 
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Stop Hydra 4-19. 
This command stops data collection from the selected Hydra. If scans remain in 
the Hydra after scanning has been stopped, the remaining scans are read (to abort 
reading the scans, click the Abort button). 

Download Configuration on Start 4-20. 
If this menu is checked, the Hydra configuration is downloaded to each Hydra 
being started when the Start Hydra or Start All Hydras command is selected. The 
logging memory contents of the being started are cleared. 

Resume Logging on Start 4-21. 
If this menu is checked, the Hydra configuration is uploaded from each Hydra 
being started. Logging memory is not cleared. (Note: Model 2635A using dc-volt 
scales 90 mV and 900 mV uploads these scales as Auto.) 

Simulate Logging on Start 4-22. 
If this menu is checked, data associated with each Hydra comes from a simulated 
source when the Start Hydra or Start All Hydras command is selected. The 
simulated data consists of repeated patterns on each channel. This selection is 
used to try out various configurations and plots before actually logging data with a 
connected Hydra. 

Plots 4-23. 
The Plots menu (below) creates and deletes trend plot windows, and allows you to 
directly select any of up to eight trend plot windows. This menu contains the 
following selections: 
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• Create Plot 
• Delete Plot... 
• Plot 1, 2 Plot 2, etc. 
In addition, each time Create Plot is selected, a new menu selection is added to the 
Plots menu item. Create Plot creates a trend plot window whose title is added to a 
numbered list of plots in the Plots menu. 

Create Plot 4-24. 
This menu selection creates a trend plot window. The trend plot is configured 
from the plot window's menu system. Up to eight plots can be created. The plots 
are given default titles, such as 1 Plot 1, 2 Plot 2, etc. Plot titles for each plot are 
listed in the Main Window Plot menu. 

Delete Plot 4-25. 
This menu selection opens a dialog box that asks you for the name of the plots to 
delete. When a deletion is made, a message is displayed warning the user that the 
plot configuration will be lost. 

1 Plot 1, 2 Plot 2, etc. 4-26. 
This menu selection causes the plot window with the corresponding title to appear 
on top of the Main Window. If the plot has been closed, it is reopened. The plot 
title can be edited from the Labels... menu selection under the Setup menu in the 
trend plot window. It is listed under the Main Window Plots menu. 

Utilities 4-27. 
The Utilities menu (below) allows you to perform a site survey to confirm the 
connection between the base station and the Remote Hydra, and allows you to 
download and upload the Hydra configuration from the Base Station. This menu 
contains the following selections: 
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• Perform Site Survey... 
• Download Hydra Configuration 
• Upload Hydra Configuration 
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Perform Site Survey... 4-28. 
The Site Survey dialog box for the selected Hydra (below) allows you to start and 
stop site survey operation. During site survey operation, commands are sent to the 
Hydra once per second, incrementing the totalizer value on the Hydra display. 
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To begin the site survey, click the Start button. At the Hydra end, click the 
TOTAL button on the Hydra front panel and observe the continually incrementing 
totalizer count to verify successful communication. At the Base Station, 
communication status (successes and failures) is displayed in the Site Survey 
dialog box. 
Site Survey is only available when logging is turned off for all Hydras (to assure 
the most accurate results). 
If the Host Computer is unable to communicate with the Base Station modem, an 
error message will occur. 

Download Hydra Configuration 4-29. 
When selected, this command downloads the Hydra configuration from the PC to 
the Hydra. If the Hydra has scans in its logging memory, a warning message 
appears, giving you the option to cancel. If you continue, logging memory is 
cleared. This command applies only to the selected Hydra. 
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Upload Hydra Configuration 4-30. 
When selected, this command uploads the Hydra Configuration from the Hydra to 
the PC. Logging memory is not cleared as a result of this command. This 
command applies only to the selected Hydra. When the upload is complete, a 
warning message appears indicated that channel labels and units labels may be 
inconsistent with the new uploaded configuration. Be sure to edit these labels to 
match the new configuration. (Note: Model 2635A using dc-volt scales 90 mV and 
900 mV uploads these scales as Auto.) 

Options 4-31. 
The Options menu (below) allows you to monitor various status indications from 
the Remote Hydras. Options also contains a selection that prevents you from 
changing certain configuration parameters in the Setup menu. The Options menu 
contains the following selections: 
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• Show Current Readings 
• Show Logging Status 
• Show Alarm Status 
• Show Logging Status on Start 
• Show Alarm Status on Alarm 
• Configuration Lockout 

Show Current Readings 4-32. 
This menu selection displays a table of readings for all 21 Hydra channels, the 
digital and alarm outputs, and the totalizer count for the selected Hydra. Only one 
readings table can be viewed at a time. The Readings window does not disable the 
Main Window while the Readings window is visible. To close the Readings 
window, select Close from the Readings window control menu. 



Wireless Logger 
Users Manual 

4-22 

Show Logging Status 4-33. 
This menu selection displays the logging status of each Hydra, including the 
current scan records in Hydra's scan memory, the total number of retrieved scans 
since the start of logging, the number of communication errors since the start of 
logging, and the type of the last communication error. The displayed error 
message is an abbreviated form of the standard error messages. Use this status 
window to verify that scans are being retrieved quickly as they are being collected 
in Hydra scan memory. The scans in Hydra value should always settle down to 
values below ten. If not, stop logging and increase the scan interval of one or more 
Hydras, then restart logging and check the logging status window again. 
The Logging Status window does not disable the Main Window while the Logging 
Status window is visible. To close the Logging Status window, select Close from 
the Logging Status window control menu. 

Show Alarm Status 4-34. 
If this menu is checked, the Alarm Status window appears on top of the Main 
Window. This window displays the alarm status of each Hydra, including the 
current scans in Hydra value, and a list of the channels in alarm for the last scan 
retrieved. 
The Alarm Status window does not disable the Main Window while the Alarm 
Status window is visible. To close the Alarm Status window, select Close from the 
Alarm Status window control menu. 

Show Logging Status on Start 4-35. 
If this menu selection is checked, the Logging Status window appears 
automatically when the Start Hydra or Start All Hydras command is completed. 

Show Alarm Status on Alarm 4-36. 
If this menu selection is checked, the Alarm Status window appears automatically 
when a channel transitions into the alarm state. A beep occurs when the window 
appears. 
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Configuration Lockout 4-37. 
If this menu selection is checked, the following configuration related menu items 
are disabled from the Setup menu: 
• Create New Hydra 
• Delete Hydra 
• Describe Hydra... 
• Edit Hydra Configuration... 
• Copy Hydra Configuration... 
The button duplicating the �Edit Hydra Configuration...� function is also disabled. 

Help 4-38. 
The Help menu (below) contains the following selections: 
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• Contents 
• Search 
• About Hydra Logger... 
Selection of the first two menu items opens the Windows Help utility with the 
corresponding help information. The �About Hydra Logger...� selection opens a 
dialog box that displays copyright information and the software version number. 
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Pruning and Grafting Utility 
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Summary of Pruning and Grafting Utility 5-1. 
Open Pruning and Grafting from the Fluke Wireless Logger group of Program 
Manager. To toggle between a partial screen and a full screen, type <Alt> 
<Enter>. The Pruning and Grafting Utility allows data files of potentially 
thousands of scan records to be reduced to only the records of interest by passing 
the data through a "filter." The output of the filter is saved in a separate ASCII 
file. Filter parameters include channels, measurement skipping, averaging, 
date/time range, greater-than, less-than, and AND/OR value limits. 
The utility merges separate data files into a single data file. The source files may 
be in the binary data file format and ASCII data file format produced by Logger, 
Starter, and Wireless Logger for Windows application software, or memory card 
binary format (Model 2635A Data Bucket only). Both utility functions can be 
applied, filtering and combining files simultaneously into a single output file. 
The main menu for the utility consists of four menus, FILE, EDIT, GO, and 
DISPLAY, plus a program setup screen summarizing the parameters of the files 
and filters. Parameters appear on the program screen as they are selected. A 
summary of the menu functions and descriptions is shown in Table 5-1. 

Table 5-1. Summary of Pruning and Grafting Menus and Windows 

FUNCTION DESCRIPTION FIGURE 

FILE Menu Manage setup files 5-1 

NEW Menu Resets setup to defaults 5-1 

SAVE Menu Saves the setup 5-1 

OPEN Menu Reads an initialization file 5-2 

SAVEAS Menu Saves setup to an initialization file 5-3 

EXIT Menu Use to exit the utility 5-4 

EDIT Menu Selects files and filters 5-5 

Input Files Menu Selects the input files for merging and filtering 5-6 

Output File Menu Selects the output file for the merged/filtered data 5-7 

Channel List Menu Selects the channels to be filtered and merged 5-8 

Filters Menu Selects the filter parameters for the selected files 5-9 

Decimal Point Menu Selects the data file separator and date format 5-10 

File Compatibility Menu Enables/disables data file compatibility checking 5-10 

Horizontal Merging Menu Selects horizontal or vertical file merging 5-11 

GO Menu Use to initiate the utility to perform its function 5-12 

DISPLAY Menu Selects background format and memory remaining 5-13 
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FILE Menu 5-2. 
The FILE menu (Figure 5-1 sets the initial conditions of the program, and creates, 
recalls, and saves program setups. The default initialization file PANDG.PNI 
loads the initial program setup. 

NEW Menu 5-3. 
Select NEW and press <Enter> to reset the program to the default values stored in 
the current initialization file. Use the entries in the EDIT menu (Figure 5-5) to 
configure the program setup for the desired operations. 

SAVE Menu 5-4. 
Select SAVE and press <Enter> to save the program setup in the current 
initialization file. For example, if the default initialization file PANDG.PNI is 
active, SAVE updates this file with the configuration shown in the program setup 
screen. 
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Figure 5-1. FILE Menu 
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OPEN Menu 5-5. 
The OPEN Menu (Figure 5-2) lists all the available program initialization files 
(default extension *.PNI). Use the SAVEAS menu (Figure 5-3) to save program 
initialization files. To load the initialization defaults into the program setup, select 
a file then press <Enter>. 
The example in Figure 5-2 shows selection of the file PANDG04.PNI. Press 
<Enter> to change the program setup screen to the parameters saved in selected 
file. 
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Figure 5-2. OPEN Menu 
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SAVEAS Menu 5-6. 
Select SAVEAS and press <Enter> to save the program setup as an initialization 
file (Figure 5-3). A prompt asks for the name of the file. 

Note 
If the file name already exists, it is overwritten without warning. 

The example in Figure 5-3 shows the program setup is saved in the file 
PANDG09.PNI. 
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Figure 5-3. SAVEAS Menu 
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EXIT Menu 5-7. 
Use the EXIT menu (Figure 5-4) to exit the Pruning and Grafting Utility. When 
the utility is initialized, the file PANDG.PNI provides the setup defaults, as does 
any subsequent OPEN menu selection (Figure 5-2). If any parameter is changed 
during operations, the program asks if the changes should be saved before 
quitting. If you select Y (Yes), a window requests the name of the initialization 
file in which to store the changes. This can be the current initialization file, a 
different file, or a new file to be created. If you select N (No), the changes to the 
defaults are not changed, and the next window verifies the Exit operation, where 
Y will exit the program, and N will return to the main menu. 
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Figure 5-4. EXIT Menu 
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Figure 5-4. EXIT Menu (cont) 
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EDIT Menu 5-8. 
The EDIT menu (Figure 5-5) selects the files and filters, the decimal point, file 
compatibility testing, and horizontal merging features. 
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Figure 5-5. EDIT Menu 
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Input Files Menu 5-9. 
The Input Files menu (Figure 5-6) records the file names for filtering or 
combining, or both filtered and combined as a simultaneous operation. If no filters 
are specified, the files simply combine into an ASCII output file. If only a single 
file is entered, it can be filtered with the results sent to an output file. Enter up to 
10 files. A full path name is used if the file is not in the current directory. 
The example in Figure 5-6 shows five files LOGDATA1.DAT through 
LOGDATA5.DAT will be filtered and combined. 
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Figure 5-6. Input Files Menu 
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Output File Menu 5-10. 
The Output File menu (Figure 5-7) specifies the name of the output file for the 
filtered and combined data. Output files are always in ASCII format. 

Note 
If an existing file name is selected, it is overwritten without warning. 

The example in Figure 5-7 shows the output file name SUMMDATA.DAT. After 
pressing <Enter>, the program setup screen changes the Output File: entry from 
blank (as shown in Figure 5-7) to SUMMDATA.DAT. 
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Figure 5-7. Output File Menu 
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Channels List Menu 5-11. 
The Channels List menu (Figure 5-8) selects the channel or groups of channels to 
be included in the output file. Channels for instrument 1 are in the range 0 to 22 
(including two pseudo channels � see below), and for instrument 2, in the range 
100 to 122. For example, to filter the measurement data for instrument 1, channel 
16, the number 16 would be entered; to filter the measurement data for instrument 
2, channel 6, the number 106 would be entered. 
To specify groups of channels, use the "-" and "," characters. For example, 
0,5,9,10 selects instrument 1, channels 0, 5, 9, and 10. The entry 105-115 specifies 
instrument 2, channels 5 to 15.  
To filter Totalizer and Alarm data, pseudo channels are assigned with channel 21 
representing the Totalizer data and channel 22 representing the Alarm data. For 
example, an entry of 22 filters the alarm data for instrument 1; an entry of 121 
filters the totalizer data for instrument 2. 
The example in Figure 5-8 shows the entry 100-122, selecting instrument 2, 
channels 0 to 20, plus the two pseudo channels 21 (Totalizer) and 22 (Alarms). 
After pressing <Enter>, the program setup screen changes the Channels: entry 
from 0-122 (as shown in Figure 5-8) to 100-122. To select all channels, enter 
ALL; to select channels that are active, enter ON. 
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Figure 5-8. Channels List Menu 
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Filters Menu 5-12. 
The Filter menu (Figure 5-9) filters the scan records for the selected channels 
(Figure 5-8). Each scan record is compared to the parameters specified in this 
menu. If the scan record meets the specified requirements, it is recorded into the 
output file (Figure 5-7). Each filter parameter is described below. 

Skip Count 
The Skip Count simply skips over n scan records. For example, if a file has 5,000 
scan records this can be reduced to 1,000 scan records by entering the number 4 
(read, skip, skip, skip, skip, read, skip, skip, skip, skip, read, etc.) 

Average Count 
The Average Count entry averages readings into a one reading. For example, a file 
with 5,000 scan records can be reduced to 1,000 averaged scan records by entering 
the number 5 (read, read, read, read, read, average, read, etc.). 

Running Average Count 
The Running Average Count levels the averaging output. The higher the entry, the 
more intense the leveling. This is a leveling function only; input scan records 
equals the number of the output scan records. Leveling is based on the following 
algorithm: Xout = (Xlast x (n-1) + Xcurrent)/n, where: 
 Xout = Value of the output scan record (the leveled value) 
 Xlast = The value of the previous Xout 
 Xcurrent = The value of the current recorded scan record 
 n = The number entered in this menu (shown as 3 in figure 5-9) 

A special case is Xout = Xfirst, where Xfirst is the very first scan record. An 
example for n=3 and ten measurements is: 
Input scan record values: 110, 113, 117, 110, 118, 114, 111, 116, 117, 112 
Output scan record values: 110, 111, 113, 112, 114, 114, 113, 114, 115, 114 

 The first Xout value is equal to the Xfirst, which is 110 
 then in sequence: Xout = (110 x (3-1) + 113)/3 = 111 
  Xout = (111 x (3-1) + 117)/3 = 113 
  Xout = (113 x (3-1) + 110)/3 = 112 
  Xout = (112 x (3-1) + 118)/3 = 114 
  Xout = (114 x (3-1) + 114)/3 = 114 
  Xout = (114 x (3-1) + 111)/3 = 113 
  Xout = (113 x (3-1) + 116)/3 = 114 
  Xout = (114 x (3-1) + 117)/3 = 115 
  Xout = (115 x (3-1) + 112)/3 = 114 
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Start Date/End Date 
Scan records can be filtered by date and time. The format is MM/DD/YY 
(Month/Day/Year [or Day/Month/Year - See Figure 5-5]) and HH:MM:SS 
(Hours/Minutes/Seconds). For example, 07/21/94 15:00:00 as a Start Date and 
07/22/94 22:00:00 as an End Data specifies that only the scan records within these 
date/time limits are recorded. 

Record Only When Greater Than/Less Than 
Further filtering is provided by channel readings above or below a specified value. 
When this filtering is desired, a check mark is placed in the box, a channel is 
specified, and then the "Greater Than" and/or "Less Than" value is entered. The 
operating mode of these filters is in either an OR configuration, where scan 
records are recorded when either the Greater Than OR Less Than conditions are 
met, or in an AND configuration where both the Greater Than AND Less Than 
conditions are met. 
The example in Figure 5-9 shows scan values are recorded only when channel 5 
measurements are greater than 120 AND channel 8 measurements are less than 
110. 
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Figure 5-9. New Title 
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Decimal Point Menu 5-13. 
The Decimal Pt menu (Figure 5-10) specifies how numbers are saved in the output 
ASCII file, as follows: 
 Separator = ,   12.345,23.456,34.567 
 Separator = ;   12,345;23,456;34,567 
 Separator = <TAB>  12,345 23,456 34,567 
These selections also set the date-reporting format Month/Day/Year (decimal 
point ".") or Day/Month/Year (decimal point "," or "<TAB>"). 

File Compatibility Testing Menu 5-14. 
The File Compatibility Testing menu (Figure 5-10) enables/disables input file 
compatibility testing. For example, combining two files where Channel 1 
measures ohms in one file and volts dc in the other results in meaningless data for 
channel 1 in the output file. Files are checked during GO (Figure 5-12). 
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Figure 5-10. Decimal Point and File Compatibility Testing Menu 
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Horizontal Merging Menu 5-15. 
The Horizontal Merging Menu (Figure 5-11) selects Horizontal or Vertical 
merging. Vertical merging (default) .merges multiple files that contain data 
acquired at different times. The data is placed in date/time order in a single output 
file. 
Horizontal merging is used to merge multiple data files that contain data acquired 
at somewhat the same time. Data from scan records from each file are merged into 
that scan record from the first file that has the closest match in time and then 
output to a single output file. 
Using a comparison to a spreadsheet, vertical merging places the scan records 
from each file in different rows, according to date/time order; Horizontal merging 
places scan records with similar data/time tags on the same row, creating more 
columns then existed on any of the input files. 
When horizontal merging is enabled, you may enter a "delta time" that is used to 
determine which records are merged. The larger the delta time, the more time is 
allowed between records from the different input files. When horizontal merging 
is enabled, channels in the first input file are selected by channel numbers 0-22; 
channels in the second file are selected by numbers 100-122, etc. 
The example in Figure 5-11 shows Horizontal merging with a delta time of 10. 
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Figure 5-11. Horizontal Merging Menu 
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GO Menu 5-16. 
The GO menu (Figure 5-12) initiates a Pruning and Grafting run with the 
configuration shown in the program setup screen. If File Compatibility Testing is 
enabled (Figure 5-5), the input files are checked before pruning and grafting. An 
error message appears if file compatibility testing fails, halting the Pruning and 
Grafting run. 

 
rs111s.bmp 

Figure 5-12. GO Menu 
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DISPLAY Menu 5-17. 
The Display menu (Figure 5-13) gives a choice of a light screen background or dark 
screen background. "PC Memory Remaining" reports the conventional DOS 
memory available after the utility is loaded. If the PC is overloaded with software 
programs, the Memory Left could fall below 32000 bytes, which is the minimum 
number for the utility to perform properly. 
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Figure 5-13. Display Menu 
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Introduction 6-1. 
Maintenance procedures in this manual are limited to the wireless modem 
information and a listing of replacement parts. Refer to the following Hydra 
manuals for Hydra maintenance information: 
• 2625A Hydra Data Logger. Hydra 2620A Series II Data Acquisition 

Unit/2625A Series II Data Logger Users Manual (Part Number 686675) 
• 2635A Hydra Data Bucket. Hydra 2635A Series II Data Bucket Users 

Manual (Part Number 686698) 
A Hydra Service Manual (Part Number 202231) is available for purchase. This 
Service Manual covers three Hydra instruments: 2620A Data Acquisition Unit, 
2625A Data Logger, and 2635A Data Bucket. 

Wireless Modem Error Codes 6-2. 
There are two types of wireless modem errors: Operating Mode Errors, and 
Configuration Mode Errors. Each is discussed below. 

Operating Mode Errors 6-3. 
The Proxim ProxLink XR wireless modem performs an internal self-check each 
time the modem is powered. The result of the self-check is indicated by the 
wireless modem PWR indicator. A steady PWR light verifies a successful self-
check; a blinking PWR light indicates an error. Error codes are signaled by 
blinking the PWR light in various patterns, as follows: 
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The Lost Communication with Destination Unit, and Destination Unit Busy errors 
appear in a point-to-point configuration. The Wireless Logger tool does not use 
the point-to-point configuration; therefore, these errors will not appear. 
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RAM Error. If the power LED is flashing evenly, a RAM error occurred during 
boot up. Unplug the wireless modem power module and then plug it in again. If 
the error indication continues, the unit has failed and must be returned for service. 
Lost Communication with Destination Unit. If the power LED is flashing one 
count, the unit has a point-to-point configuration and it can no longer 
communicate with the remote unit. In this case, the error likely means that the 
remote unit is either out of range or has been turned off. A unit will enter this 
error state only after it has made numerous attempts to reestablish communication. 
[This application of the wireless modem does not use a point-to-point 
configuration and this error should not occur.] 
Destination Unit Busy. If the power LED is blinking two counts, the unit has a 
point-to-point configuration and can no longer communicate with the remote unit. 
In this case, the error indicates that the remote unit configuration is no longer set 
up for point-to-point communication with this unit. [This application of the 
wireless modem does not use a point-to-point configuration and this error should 
not occur.] 
Internal Software Error. If the power LED is blinking five counts, the unit has 
experienced an internal error. Unplug the wireless modem power module and then 
plug it in again. If the error indication continues, the unit has failed and must be 
returned for service. 

Configuration Mode Errors 6-4. 
Wireless modem Configuration Mode Errors are ASCII strings relayed from the 
Base Station wireless modem to the Host Computer, over the RS-232 connection 
during wireless modem configuration. Each error and description is listed below. 
• The input given was too long!  The number of characters in the last input 

line is longer than the maximum number of characters expected. 
• Invalid number!  The last input line has an invalid format. This is different 

from the "Value given in not in range allow!" error message. 
• Value given is not in range allowed!  the last input line specified a value that 

is not in range for the parameters being specified. 
• Invalid option!  The menu option selected is not one of the valid options for 

the current menu. 
• Serial #nnnnn, is not responding!  This message occurs when the remote 

unit (serial number nnnnn) is not responding correctly to messages during a 
remote configuration. The remote unit in this case is in a state where it is 
ignoring remote configuration requests. This situation occurs only when the 
unit is in the process of being configured by yet a different unit. 

• Serial #nnnnn, ignored request!  This message occurs when the remote unit 
(serial number nnnnn) is not responding correctly to messages during a remote 
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configuration. The remote unit in this case is not responding to radio 
messages. The unit is probably: (1) turned off, (2) set to a different radio 
channel, (3) set to a different network subchannel, (4) currently in the user 
interface mode, or (5) defective. 

• Serial #nnnnn, has already been remotely configured!  This message 
occurs when the remote ProxLink unit (serial number nnnnn) is not 
responding correctly to messages during a remote configuration. the remote 
unit is this case has already been remotely configured for a point-to-point 
communication by another unit. In this case, the user is given the option of 
overriding the remote unit's configuration. 

• Serial #nnnnn, has already been locally configured!  This message occurs 
when the remote ProxLink unit (serial number NNNNN) is not responding 
correctly to messages during a remote configuration. The remote unit in this 
case has already been configured using its own user interface. In this case, the 
user is given the option of overriding the configuration of the remote unit. 

Wireless Modem Servicing Information 6-5. 
The wireless modems are not user serviceable. During the warranty period, return 
any unit that fails to a Fluke Service Center for repair or replacement.  
To contact Fluke, call one of the following telephone numbers: 
USA and Canada:  1-800-44-FLUKE  
(1-800-443-5853)  
Europe:  +31 402-678-200  
Japan:  +81-3-3434-0181  
Singapore:  +65-*-276-6196   
Anywhere in the world:  +1-425-356-5500 
Or, visit Fluke's Web site at www.fluke.com. 
After the warranty period, you may elect to return the unit to a Fluke Service 
Center for repairs, or return the wireless modem directly to the Proxim factory. 
When returning the unit to the Proxim factory, telephone first (415) 960-1630 for 
a Return Merchandise Authorization (RMA) number, and then ship the unit, with 
the RMA number displayed on the shipping label, to Proxim, 295 N. Bernardo 
Avenue, Mountain View, California 94043. 



Wireless Logger 
Users Manual 

6-6 

Wireless Logger Tool Replacement Parts 6-6. 
Replacement parts are shown in the following table. To order replacement parts in 
the USA, call 1-800-526-4731. To order parts from outside the USA, contact the 
nearest Fluke Service Center. (See Appendix E for a list of Service Center 
locations.)  Other Wireless Logger components, options, and accessories are listed 
in Table 1-1. 

Part Number Description 

485706 Two-Receptacle Power Cable 

868153 DB25-to-DB9 Cable Adapter 

897256 Wireless Modem, ProxLink XR [Note 1] 

104312 Wireless Modem, ProxLink PL [Note 1] 

929018 Short RS-232 Cable (Hydra to Wireless Modem) 

929034 Wireless Modem Power Module (Remote) [Note 2] 

929138 Wireless Modem Antenna for Proxlink XR (1/4 Wave) 

944876 Wireless Modem Antenna for ProxLink PL (5/8 Wave) 

929141 Wireless Modem Power Module (Base Station) [Note 2] 

929146 Wireless Modem RS-232 Cable 

929166 Modem Labels 

929380 Wireless Modem Antenna 90-degree SMA adapter (for XR only) 

936562 Wireless Logger Users  Manual 

688036 2.4 GHz  Antenna 

688721 7.5 V AC to DC Power Adapter 

688033 Line Cord, Connector, Europe 

688462 Line Cord, Connector, USA 

688432 Line Cord, Connector, Australia 

688439 Line Cord, Connector, UK 

110528 Wireless Modem United States 

686675 2620A/2625A Series II User Manual 

686698 2620A.2625A Series II Service Manual 
Note 1. The Proxim ProxLink XR Wireless Modem can be repaired or replaced under the Fluke 
Product Exchange Program (PEP). Contact the nearest Fluke Service Center for instructions. 
 
Note 2. If either modem power module should fail, use only the factory replacement part. The 
modem power module electrical and physical characteristics must be exact. 
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Appendix A 
Specifications

Introduction A-1. 
The specifications presented here apply only to the Proxim ProxLink XR Wireless 
Modem. Specifications for the Hydras may be found in one of the following 
manuals: 
• 2625A Hydra Data Logger.  Hydra 2620A Series II Data Acquisition 

Unit/2625A Data Logger Users Manual (Part Number 686675) 
• 2635A Hydra Data Bucket.  Hydra 2635A Series II Data Bucket Users 

Manual (Part Number 686698) 

900 Mhz Wireless Modem Specifications 

Specification Description 
Serial Interface  
 Data Rates 1.2K, 2.4K, 4.8K, 9.6K, 19.2K Baud 
 Data Format 8 Data Bits, No Parity, 1 Stop Bit 
 Flow Control CTS, DSR, XON/XOFF 
 Connector DB9 - 9-pin Female D Connector 
Radio  
 Model RDA-500 
 Power Output 500 mW (Nominal) 
 Data Rate 121 Kbps 
 Total Channels 7 
 Independent Channels 4 
 Nominal Range 800 Feet 
Power  
 Power Connector 2.5mm male DC Power Jack 
 Required Source 9V dc (9.5V dc maximum) 
 Transmit Current 350 mA @ 9V dc 
 Receive Current 150 mA @ 9V dc 
 Standby Current 15 mA @ 9V dc 
 Power Up Time Less than one second 
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900 Mhz Wireless Modem Specifications (cont) 

Packaging  
 Antenna 1/4-wave with 0 dB gain (approx. 4-inches) 
 Package Size (without Antenna) 4.0" x 6.5" x 0.75" 
 Weight (with Antenna) 12 oz. 
 LEDs Power, Carrier Detect, Receive Data 
Environment  
 Temperature - Operating -20° to +60° C 
 Temperature - Storage -50° to +85° C 
 Relative Humidity 20% to 90% (non-condensing) 
Software  
 Operating Modes Off-line Configuration 
  Pass-Through Transparent to application 
  Packetized Real-time configuration, message, and 

status commands 
 Message Format Options Line length, delimiters, and input time-out 
 Network Parameters  
  Channel Options Radio channel and security subchannel 

(16 bits) 
  Outgoing Messages Directed or Broadcast 
  Incoming Messages Directed, Broadcast or all 
 Packetized Mode Features Radio signal strength, standby mode, 

message status, and error report 
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2.4 GHz Wireless Modem Specifications 

Specification Description 
Serial Interface  

Data Rates 112.5 to 115200 baud 
Data Format 7 or 8 Data Bits, 1, 1.5, or 2 stop bits; even, 

odd, or no parity 
Control Lines TXD, RXD, RTS, CTS, DTS, DSR @RS-

232 levels 
Configure and Reset control lines  
Pinout Wire to the DCE [Data Communication 

Equipment] specification, except for pins 1 
and 9.  
1 - Configure, 2 - TX, 3 - RX, 4 - DTR, 5 - 
GND, 6 - DSR, 7 - RTS, 8 - CTS, 9 - Reset 

Connector Female DB-9  
Radio  

Model RF1 
Frequency 2.4 - 2.4835 GHz 
Compatible with the Proxim 
RangeLAN2 

 

Technology Frequency hopping, spread spectrum 
Channels 15 independent 
Power Output 100 mW 
Data Rate 1.6 Mbits/sec 
Modulation 4fsk (bsk in back off mode) 

Power  
 Input voltage 6 - 15 VDC 
 Input current 675 mA RX typical 

850 mA TX typical 
Standby mode < 40 mA 
Sleep mode < 10 mA 

 Power connector 2.5 mm dc power jack 
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2.4 GHz Wireless Modem Specifications (cont) 

Physical  
     Imperial Dimensions 5.5 X 2.77 X .88 inches, weight: 10 ounces 
 Metric Dimensions 14.0 X 7.0 X 2.2 centimeters, weight: 200 

grams 
Environment  
 Temperature - Operating -20° to +60° C 
 Temperature - Storage -50° to +85° C 
 Relative Humidity 20% to 90% (non-condensing) 
Software  
 Operating Modes Off-line Configuration 

 Pass-Through Transparent to application 
Off-line configuration 
Line length, delimiters, input timeout as  
message format options 

 Packetized mode Accepts and generates real-time 
configuration, message, and status 
commands 
Radio signal strength, standby mode, 
message status, error reporting, site 
survey, and rf snooping survey 
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Appendix B 
File Formats

File Formats B-1. 
The data file is maintained in comma-separated ASCII format (identical to the 
Hydra Logger ASCII data file format). The ASCII format is compatible with data 
analysis and management tools running simultaneously in other computers on a 
network. 
Data files are opened in SHARED mode with write blocked. This enables network 
reads but no writes of the data file while scan data is being recorded. Between 
scans, the file is closed, allowing full network access to the file (including delete 
if allowed by the security level enabled on the Host Computer). If the file 
disappears between one scan and the next, a new file (including header and with 
the previous file name) is created before new scan data is recorded. 
The comma separated ASCII file format is as follows (<EOL> means �end of 
line�, a <CR><LF> sequence): 
• File name string (< 15 characters) followed by: 
• Special format (internally-used) string (8 characters) <EOL> 
• Date and time file was created <EOL> 
• File Comment(< 70 characters) <EOL> 
• Number of Hydras (always 1) <EOL> 
• Channel Units string (25 comma-separated strings) <EOL> 
• Scan Record 1 <EOL> 
• Scan Record n <EOL> 
Each scan record consists of the Hydra timestamp (the user's choice of absolute 
time, date/time string, or elapsed time) and a comma-separated list of channel 
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readings (including the DIO word, and totalizer). The strings are surrounded by 
quotes to allow direct importation into spreadsheet programs and other data 
analysis and presentation packages. 
In this format, each recorded scan consumes about 300 bytes. A 1 Megabyte file 
can store about 3330 scans. 
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Appendix C 
Error Messages

Introduction C-1. 
This appendix provides a summary of all possible Wireless Logger for Windows 
error messages.   The following paragraphs identify the group messages, which is 
followed by the individual messages found in each group. 

Group Error Messages C-2. 

Error Messages C-3. 
A variety of error messages may occur during operation of the Wireless Logger 
data acquisition tool (Wireless Logger tool).  In most cases, the problems causing 
the errors may be fixed relatively easily. 
If you have received an error message, check the list below for clues as to what 
caused the error, and refer to the individual error messages that follow: 

Errors When Starting Application C-4. 
Window creation failed! 
Error registering window class! 
Wireless Logger is already running! 
Must run in protected mode (standard or enhanced)! 
Unable to initialize DDE! 
No timers available! Close another application and try again! 
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Errors When Starting Hydra C-5. 
Hydra X: No channels defined! 
Hydra X: N scan(s) in Hydra memory will be lost! 
Hydra X: Calibration Corrupted! Continue? 
Hydra X: Date/Time Corrupted! Check Hydra clock. 

Errors When Opening or Creating New Windows C-6. 
Unable to Create Plot Window! 
Maximum number of plots reached! 
Low on memory! 
Maximum number of Hydras reached! 

Errors When Logging C-7. 
Cannot close application while Hydras are logging! 
Hydra X: Cannot change Configuration while logging! 
Hydra X: Communication Interruption! 
Hydra X: Hydra Scan Memory Full! 
Hydra X: Unable to Write to Data File! 

File Related Errors C-8. 
Unable to Open Setup File! 
Unable to Write to Setup File! 
Setup File is Invalid! 
Unable to Create Configuration Text File! 
Unable to Write to Configuration Text File! 
Hydra X already has this filename! 

Communication Errors C-9. 
Hydra X: Hydra Execution Error! 
Hydra X: Hydra Command Error! 
Hydra X: RF Transmission Error! 
Hydra X: Time-out waiting for Hydra! 
Hydra X: Time-out waiting for Base Station! 
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Hydra X: RS-232 Communications Error! 
Hydra X: Not enough memory to perform operation! 
Hydra X: Unable to initialize communications port! 
Hydra X: Unsupported model or version of Hydra! 

Individual Error Messages C-10. 

Window Creation Failed! C-11. 
The application was unable to create a new window.  This error may occur if not 
enough memory is available.  Close some applications, or exit and restart 
Windows, then try again. 

Error Registering Window Class! C-12. 
The application was unable to register the window class.  This error may occur if 
not enough memory is available.  Close some applications, or exit and restart 
Windows, then try again. 

Wireless Logger is Already Running! C-13. 
Only one instance of the Wireless Logger for Windows application may be open at 
once.  Either close the existing application and begin again, or use the application 
that is already open. 

Must Run in Protected Mode (Standard or Enhanced)! C-14. 
Restart Windows to run in protected mode (standard or enhanced). 

Unable to Initialize DDE! C-15. 
An error occurred while trying to initiate DDE.  Try closing some other 
applications that are currently using DDE and try again. 

No Timers Available! C-16. 
Wireless Logger for Windows requires the use of a timer.  This error occurs when 
all timers (a limited Windows resource) are being used by other applications.  
Close some applications that are using timers (for example, the clock application 
under Windows Accessories) and try again. 

Hydra X: No Channels Defined! C-17. 
None of the channels on Hydra X has been defined.  You must define at least one 
channel for the Hydra before attempting to start logging with the Hydra. 



Wireless Logger 
Users Manual 

C-4 

Hydra X: N Scan(s) in Hydra Memory Will be Lost! C-18. 
This warning occurs when a Hydra configuration is about to be downloaded to the 
Hydra, and scans still in Hydra memory will be cleared as a result.  Scans may be 
left in Hydra memory if some loss of communication has occurred, or if Wireless 
Logger for Windows attempts to retrieve the remaining scans after you stop 
logging and you abort the retrieval. 
To continue and erase the stored scans, click Yes.  To cancel, click No. 
If you are attempting to start the Hydra logging but do not want to lose the scans 
currently in Hydra memory, select Resume Logging on Start under the Logging 
menu and try starting the Hydra again.  Since the configuration is uploaded to the 
Host Computer instead of downloaded to the Hydra, the scans in the Hydra 
memory are not cleared. 

Hydra X: Calibration Corrupted! C-19. 
The Hydra's calibration constants have been corrupted.  The Hydra instrument 
needs to be recalibrated.  See the Hydra manual's maintenance section for 
information on servicing the instrument. 

Hydra X: Date/Time Corrupted! C-20. 
The Hydra instrument no longer contains a valid date and time.  Press the <Shift> 
INTVL button on the front panel of the Hydra instrument to ensure that the date 
and time are correctly set.  This message can also occur if the Hydra's internal 
clock has failed.  In this case, see the Hydra manual's maintenance section for 
information on servicing the instrument. 

Unable to Create Plot Window! C-21. 
The application was unable to create a new trend plot window.  This error may 
occur if not enough memory is available.  Close some applications, or exit and 
restart Windows and then try again. 

Maximum Number of Plots Reached! C-22. 
The maximum number of trend plots (eight) have already been created.  To delete 
one of the existing plots, select Delete Plot from the Plots menu. 
Note that not all of the trend plot windows may be visible.  All existing plots are 
listed in the Plots menu. 

Low on Memory! C-23. 
There is not enough memory to complete the current operation.  Either close some 
applications, or exit and restart Windows. 
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Maximum Number of Hydras Reached!. C-24. 
The maximum number of Hydra instruments (20) have already been created.  An 
unused Hydra may be reconfigured for use, or deleted by selecting it and then 
selecting the Delete Hydra command from the Setup menu. 

Cannot Close Application While Hydras are Logging! C-25. 
You must stop logging on all Hydra instruments before exiting Wireless Logger 
for Windows.  Use Stop All Hydras under the Logging menu to stop logging on all 
Hydras, then exit the application. 

Hydra X: Cannot Change Configuration While Logging! C-26. 
This message appears if you attempt to copy a Hydra configuration from one 
Hydra to a Hydra that is currently logging.  Use Stop Hydra to stop logging on the 
Hydra you are copying to before attempting to change its configuration. 

Hydra X: Communication Interruption! C-27. 
Communication with the Hydra instrument has been interrupted.  If this message 
occurs during logging, check the Logging Status window for the current 
communication status.  If the total number of errors for the Hydra continually 
increase, communication is still being interrupted. 
To prevent this error message window from reappearing, click on the Disable this 
warning check box.  The error message is not displayed again until you exit and 
restart the Wireless Logger for Windows application. 

Hydra X: Hydra Scan Memory Full! C-28. 
Hydra scan memory is full.  This condition occurs when scans are being collected 
in Hydra scan memory faster than Wireless Logger for Windows can retrieve them 
and the scan memory eventually fills up.  This may be caused by frequent or 
prolonged communication interruptions that prevent Wireless Logger for Windows 
from retrieving scans fast enough, or by the Hydras being configured for short 
scan intervals such that Wireless Logger for Windows cannot keep up even under 
ideal communication conditions. 
When Hydra scan memory becomes full, the Hydra instrument either overwrites 
the oldest scans in memory or stops storing new scans.  The oldest scans are 
overwritten if the Wrap-Around Logging Mode has been enabled in the Hydra 
Configuration dialog box. 
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Hydra X: Unable to Write to Data File! C-29. 
Wireless Logger for Windows was not able to write Hydra scan data to the data 
file.  This could indicate that the directory structure for the data file has been 
deleted, that the application no longer has write permission for the file, or that the 
disk is full. 

Unable to Open Setup File! C-30. 
The application was not able to open the setup file specified on the command line 
or with the Load Logger Setup... command. 
Ensure that the full path of the setup file is correct, and that the file exists.  If this 
error occurs when starting Wireless Logger for Windows with a setup file on the 
command line, be sure you have the correct command line format: 
If you use Save Logger Setup under the Setup menu item, the application attempts 
to save the setup file using the directory structure of the previous Save Logger 
Setup As... command.  If the directory structure has changed, the application 
cannot save the setup file.  Try using the Save Logger Setup As command. 
Another possible cause of this error may be that another application has opened 
the file, denying write permissions to other applications. 
The FILES setting in CONFIG.SYS file should be set to at least 30. 

Unable to Write to Setup File! C-31. 
The application was not able to write to the setup file. 
Ensure that the setup file exists and is located in the proper directory.  If you use 
Save Logger Setup under the Setup menu item, the application attempts to write to 
the setup file using the directory structure of the previous Save Logger Setup As... 
command.  If the directory structure has changed, the application cannot write to 
the setup file.  Try using the Save Logger Setup As command. 
The FILES setting in CONFIG.SYS file should be set to at least 30. 

Setup File is Invalid! C-32. 
The selected setup file is either not a Wireless Logger for Windows setup file or its 
contents have been corrupted. 
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Unable to Create Configuration Text File! C-33. 
The application was not able to create the Hydra configuration text file.  Make 
sure that the full path of the file is correct. 
The FILES setting in CONFIG.SYS file should be set to at least 30. 

Unable to Write to Configuration Text File! C-34. 
The application was not able to write to the Hydra configuration text file.  This 
error may occur if the disk becomes full. 
The FILES setting in CONFIG.SYS file should be set to at least 30. 

Hydra X Already has this Filename! C-35. 
Another Hydra has already been assigned this filename.  Multiple Hydras cannot 
log data to the same file. 

Hydra X: Hydra Execution Error! 
The Hydra received an incorrect command, possibly due to a communication 
error.  Retry the operation. 

Hydra X: Hydra Command Error! 
The Hydra received a command it did not recognize, probably due to a 
communication error.  Retry the operation. 

Hydra X: RF Transmission Error! 
The Base Station modem was unable to transmit to the remote modem.  This error 
occurs if the remote modem is out of range, turned off, or not configured to 
receive messages from the Base Station modem. 

Hydra X: Time-Out Waiting for Hydra! C-36. 
The Hydra was unable to communicate with the Host Computer.  This error occurs 
when the Hydra is turned off, configured for the wrong baud rate or parity, not 
connected to the remote modem (or to the Host Computer for a local Hydra), not a 
Hydra instrument, or not quite in range to send a response to the Base Station, but 
close enough to receive the command from the Base Station. 
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Hydra X: Time-Out Waiting for Base Station! C-37. 
The Base Station Host Computer is unable to communicate with the Base Station 
modem. 
Use the Windows Terminal emulator to restore communication.  Ensure that the 
baud rate, parity, etc. are correct. 
Check the cable between the Base Station and the modem for proper connection.  
Make sure that the cable is connected to the correct COM port, and that the port 
has been properly set up to communicate with the modem.  Verify the modem 
configuration parameters. 
This error can also occur if the Base Station modem cannot determine when a 
packet begins and ends (due to disruptions in the RS-232 cable).  To overcome 
this problem, it may be necessary to cycle power on the Base Station modem. 

Hydra X: RS-232 Communications Error! 
This message appears when an error occurs over the RS-232 serial port.  
Occasional RS-232 errors occur more often for high baud rates, and during file 
operations or network accesses. 
If this error occurs repeatedly, there may be a more serious problem.  First, verify 
that the serial port settings in Wireless Logger for Windows match the settings in 
the Base Station modem or the local Hydra.  If these are correct, the problem is 
probably due to a hardware conflict in the Host Computer, such as a serial mouse 
or an internal modem sharing the same interrupt request line as the serial port. 

Hydra X: Not Enough Memory to Perform Operation! C-38. 
Not enough memory is available to perform the operation.  Close some other 
applications and try again. 

Hydra X: Unable to Initialize Communications port! C-39. 
Wireless Logger for Windows is unable to initialize the Host Computer's serial 
COM port.  This indicates that the COM port does not exist or is being used by 
another application.  (Be sure that you close the terminal emulator program after 
you have finished configuring the modems.)  Also be sure that the COM port 
selected for a local Hydra is not the same as he COM port selected for the Base 
Station modem in the Wireless Logger for Windows application. 
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Hydra X: Unsupported Model or Version of Hydra! C-40. 
This error occurs if you are using any Hydra instrument other than a model 2625A 
or model 2635A using software version 5.5 or later.  To determine the version of 
the software running on the 2625A, press the right and left arrow keys on the 
Hydra instrument simultaneously.  The version number is shown in the center of 
the display.  Press the CANCL key to exit. 
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Appendix D 
Dynamic Data Exchange (DDE)

Dynamic Data Exchange (DDE) D-1. 
Dynamic Data Exchange allows you to transfer data between applications, and 
updating the data as it is being gathered.  
To display the data, you must first link the application (such as a spreadsheet) to 
the Wireless Logger for Windows application. You must enter the application 
name (Wlogger), a topic and an item before the link can be established. In some 
cases, the link is established by entering the application name, topic, and item into 
a formula for a specific cell. Other applications allow you to enter the application 
name, topic, and item into a dialog box. Once the link is established, Wireless 
Logger for Windows updates the application with new data whenever the data 
changes. 
In many applications, you can also manipulate the data that is being received from 
the Wireless Logger for Windows application using Macros. See the application 
manual for more information.  
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The following application name, topics, and items are available for Wireless 
Logger for Windows (the names are not case sensitive):  
Application name:  Wlogger  
Topics:  System   System Topic  
 HydraX   Number of the Hydras from the 
    Hydra Selection Icon Bar (X can be 1 
   through 20)  
Items (System Topic): Topics   List of Topics ("System, Hydra 1,  
   Hydra2, ...")  
 Systems   List of System Items ("Topics, 
   SysItems, Formats")  
 Formats   List of DDE formats ("TEXT")  
Items (Hydra Topic): cX   Channel X reading (X can be 0 
   through 20)  
 Hydra_Name   The name of the selected Hydra 
   instrument (set using Describe Hydra 
   under Setup)  
 RdateTime   Seconds since 00:00:00 01/01/1970  
 ELdateTime   Date/time format compatible with  
   Excel and Lotus 1-2-3  
 DIO   Hydra DIO, DIO 0 through 11 
  (includes DIGITAL I/O and ALARM 
   OUTPUTS)  
 Totalizer   Hydra totalizer value  
For example, to access the data from channel 10 of Hydra instrument number 1 
within an Excel spreadsheet cell, use:  
  =Wlogger|Hydra1!c10  

to get the name of the Hydra instrument number 6:  
  =Wlogger|Hydra6|Hydra_Name 

Examples for linking Hydra data within both Lotus 123 and Quattro pro (those 
versions which support DDE) are as follows: 

For Lotus 123:  @DDELINK (“Wlogger”, “Hydra1”, “C10” ) 

For Quattro Pro:  @DDELINK ( [ Wlogger | Hydra1] “C10”) 

Note 
In the examples above please note �|� is a pipe symbol, and there 
are no spaces in the example phrase. 
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Appendix E 
Exception Condition Handling

Exception Condition Handling E-1. 
This appendix describes how Wireless Logger for Windows handles exception 
conditions during operation. 

Communication Errors E-2. 
If a communication error occurs (time-out, RF transmission error, overrun, 
framing, or parity) during the reception of scan data, the request for data is 
repeated up to three times.  If all three attempts fail, Wireless Logger for Windows 
then goes on to service the other Hydras before again asking the Hydra for data.  
The number of accumulated communication errors appears in the Logging Status 
window, along with a short description of the last communication error. 
If the communications connection to a Hydra is interrupted during logging, 
Wireless Logger for Windows times out each time it attempts to communicate with 
the Hydra.  These time-outs appear as communication errors in the Logging Status 
window display, and a window is displayed with a warning message, bringing the 
Wireless Logger for Windows application to the top. 
After communications are restored, if the Hydra's scan memory has become full, a 
window with a warning message indicating possible data loss is displayed. 
Wireless Logger for Windows attempts to retrieve scans stored in the Hydra's scan 
memory during the communication loss. 

Full-Disk E-3. 
If the disk becomes full during data collection or if the directory structure is 
deleted such that attempts to write to the data file fail, subsequent scans are not 
recorded, but communication with the Hydra and data display continues.  A 
window with a warning appears, bringing the Wireless Logger for Windows 
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application to the top.  When the problem is fixed, Wireless Logger for Windows 
resumes recording scans in the file. 

Invalid Entries E-4. 
Diagnostic messages are displayed if the user enters invalid values into the fields 
of a dialog box. 

Loss of Power E-5. 
Complete the following procedure to automatically resume data collection after a 
loss and then restoration of power to the Host Computer. 
1. In DOS, verify that the AUTOEXEC.BAT file includes WIN to start windows 

when power is returned to the Host Computer.  Be sure there is nothing in the 
AUTOEXEC.BAT or in Windows that requires a prompt, e.g., network name, 
passwords, etc. 

2. In Program Manager, select the Copy... command from the File menu to copy 
the Wireless Logger icon (in the Fluke Wireless Logger group) to the 
Windows StartUp group.  Create the StartUp group if it does not exist using 
the New... command from the File menu in Program Manager. 

3. Highlight (but do not open) the Wireless Logger icon in the StartUp group.  
Select the Properties command from the File menu in Program Manager.  At 
the end of the Command Line in the Program Item Properties dialog box, add 
the name of the special setup file that will be in use when the Host Computer 
power is restored, and follow this with the /G switch.  For example, using the 
special setup file SETUPG.STP, the entire Command Line would read: 
C:\WIRELESS\WLOGGER.EXE SETUPG.STP /G (below).  
SETUPG.STP (for example) is a special setup file that is identical to the 
normal setup file, except for a few settings described below. 

  
4. Open Wireless Logger from the Fluke Wireless Logger group of Program 

Manager.  Select the Load Logger Setup... command from the Setup menu, 
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and select the desired setup file for normal operations.  For example, 
setup.stp.  Click OK. 

5. Select the Save Logger Setup As... command from the Setup menu and enter 
the name of the special setup file.  For example, setupg.stp.  Click OK.  
This filename must agree with the filename entered in step 3. 

6. Add the following selections to the special setup file: select the Resume 
Logging on Start command from the Logging menu, and for each Hydra, 
select Append to File in the Data File Configuration dialog box (click the Edit 
Hydra Config... button, then Data File... button).  Click OK twice to return to 
the Main Window. 

7. Select the Save Logger Setup command from the Setup menu to save the 
selections entered in step 6. 

8. To test the automatic data collection feature when power is lost, close all 
Windows applications except for Wireless Logger for Windows.  Click the 
Start Hydra button in the Wireless Logger for Windows Main Window and 
verify data collection activities. 

9. Turn the Host Computer power off, pause, and then on again.  Observe the 
Host Computer reboots and resumes Wireless Logger for Windows data 
collection activities, as displayed on the Logging Status dialog box. 
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